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PENINGKATAN PRESTASI SISWA DALAM PEMBELAJARAN PLC
MELALUI PENDEKATAN PROBLEM POSING PADA SISWA SMKN 2

WONOSARI
Oleh:

Hizkiawan Krisdianto
06518241007
ABSTRAK

Penelitian ini merupakan penelitian tindakan kelas yang bertujuan untuk
meningkatkan prestasi siswa dalam pembelajaran PLC melalui pendekatan
problem posing pada siswa kelas IX EI SMKN 2 Wonosari dan mendiskripsikan
respon siswa kelas XI EI SMKN 2 Wonosari terhadap pembelajaran PLC melalui
pendekatan problem posing.

Penelitian ini diadakan dalam 2 siklus dengan setting penelitian tindakan
kelas. Siklus pertama terdiri dari 2 kali pertemuan dan siklus 2 terdiri dari 2 kali
pertemuan. Instrumen yang digunakan dalam penelitian ini berupa lembar
observasi aktivitas, keterlaksanaan dan tes. Pengumpulan data dilakukan dengan
cara observasi dan tes tertulis. Data yang diperoleh akan dianalisis menggunakan
metode deskriptif.

Hasil penelitian menunjukan bahwa pelaksanaan pembelajaran dengan
pendekatan problem posing dapat meningkatkan prestasi siswa kelas XI EI
SMKN 2 Wonosari yang ditunjukan oleh: (1) Pada siklus I perolehan nilai rata-
rata aktivitas  siswa adalah 49,80% sedangkan pada siklus II perolehan nilai rata-
rata aktivitas siswa  adalah 55,67%, terjadi peningkatan kearah perbaikan sebesar
11,78%. (2) Prestasi siswa dari siklus I dan siklus II mengalami peningkatan. Pada
siklus I nilai rata-rata tes siswa sebesar 66,5. Pada siklus II nilai rata-rata tes siswa
menjadi 70. Penerapan pendekatan pembelajaran problem posing dapat
meningkatkan prestasi siswa sebesar 5,26%

Kata Kunci: pembelajaran problem posing, prestasi siswa
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BAB I

PENDAHULUAN

A. Latar Belakang Masalah

Perkembangan dan perubahan kehidupan bermasyarakat, berbangsa

dan bernegara di Indonesia tidak lepas dari pengaruh Ilmu Pengetahuan dan

Teknologi (IPTEK). Kemajuan ilmu pengetahuan tersebut, menuntut

seseorang untuk dapat menguasai informasi dan pengetahuan. Dengan

demikian diperlukan suatu kemampuan memperoleh, memilih dan mengolah

informasi. Kemampuan-kemampuan tersebut membutuhkan pemikiran yang

kritis, sistematis, logis, dan kreatif. Salah satu cara untuk mengembangkan

kemampuan-kemampuan tersebut adalah dengan pendidikan.

Pendidikan adalah sebuah proses belajar yang tidak ada batasnya.

Melalui pendidikan dapat ditemukan hal-hal baru, dan dikembangkan untuk

menghadapi tantangan dalam kehidupan dan perkembangan zaman. Hal ini

sudah jelas bahwa peran pendidikan amatlah penting bagi kelangsungan

hidup manusia.

Sekolah Menengah Kejuruan (SMK) merupakan lembaga pendidikan

yang menjadi penghasil pekerja teknik tingkat menengah yang sangat

dibutuhkan oleh dunia industri. Pendidikan SMK merupakan lanjutan

pendidikan dasar yang mempunyai tujuan utama untuk menyiapkan tenaga

kerja sesuai tuntutan dunia kerja. Pengetahuan dan ketrampilan yang relevan
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dengan dunia industri, harus ditanamkan pada para siswa di SMK sebagai

bekal masuk ke dunia industri.

PLC merupakan salah satu mata pelajaran yang diajarkan di SMK.

Berdasarkan isi materi dan target kompetensi yang ditetapkan, target

kompetensi mata pelajaran PLC diantaranya adalah peserta didik mampu

menganalisis dan memprogram PLC. Oleh karena itu permasalahan yang

perlu dicari solusinya adalah bagaimana usaha yang tepat untuk mengajarkan

mata diklat tersebut agar peserta didik dapat dengan mudah mampu

menguasainya. Diharapkan dengan penguasaan materi yang baik, prestasi

siswa dalam mata pelajaran PLC dapat meningkat.

Prestasi belajar siswa pada mata pelajaran PLC siswa SMKN 2

Wonosari masih kurang. Hal tersebut dapat diketahui berdasarkan hasil ujian

mata pelajaran PLC. Masih banyak siswa yang mendapat nilai kurang dari

yang diharapkan. Rendahnya hasil belajar siswa pada mata diklat PLC

merupakan tantangan tersendiri bagi guru di SMKN 2 Wonosari. Peningkatan

hasil belajar tersebut dapat diupayakan dengan mengubah pendekatan

pembelajaran.

Berdasarkan pemikiran di atas dan observasi selama KKN-PPL di

SMKN 2 WONOSARI terlihat bahwa, adanya rasa enggan siswa dalam

bertanya kepada guru apabila siswa belum paham mengenai materi yang

dijelaskan guru. Siswa juga merasa malas untuk memberikan pendapat

mereka dalam menyelesaikan soal. Dalam pembelajaran PLC terlihat bahwa,

siswa kurang tertarik atau kurang memberi respon yang positif terhadap
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pembelajaran PLC. Dalam menyelesaikan soal siswa hanya berorientasi pada

bentuk gambar leader diagram. Siswa cenderung menghafal bentuk gambar

leader diagram, tanpa tahu bagaimana program itu bekerja. Hal tersebut

mengakibatkan kemampuan berfikir siswa dalam menyelesaikan soal kurang

berkembang.

Syaiful Bahri Djamarah (2002:44) menyatakan, tujuan pembelajaran

dapat tercapai jika siswa berusaha secara aktif untuk mencapainya.

Pembelajaran seharusnya dapat memberikan kesempatan pada siswa agar

terlibat aktif, sehingga siswa dapat mengungkapkan ide, gagasan, dan konsep

secara optimal. Sesuai pendapat Oemar Hamalik (2005:17), pembelajaran

yang efektif adalah pembelajaran yang menyediakan kesempatan kepada

siswa untuk belajar mandiri, sehingga dengan melakukan aktifitas belajar

siswa mampu memperoleh pemahaman sendiri.

Untuk dapat melibatkan siswa secara aktif dalam pembelajaran, guru

sebaiknya memilih cara mengajar atau pendekatan yang dapat membantu

mengembangkan pola pikir siswa. Salah satu cara untuk merangsang

keaktifan siswa adalah dengan memberikan tugas kepada siswa untuk

membuat soal sendiri yang berhubungan dengan materi yang telah diajarkan,

kemudian mengerjakan soal tersebut. Pendekatan pembelajaran yang

mendorong siswa untuk membuat soal sendiri dan menyelesaikannya disebut

pendekatan problem posing. Kegiatan membuat sendiri dan menyelesaikanya

memberikan kesempatan pada siswa untuk mengembangkan kemampuan

berfikirnya. Informasi yang ada diolah dalam pikiran dan setelah paham,
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siswa akan dapat membuat soal, sehingga merangsang siswa untuk berfikir

dan menganalisa soal lebih baik. Suparno (Abdussakir 2009) menyatakan

bahwa mengungkapkan pertanyaan merupakan salah satu kegiatan yang dapat

menantang siswa untuk lebih berfikir dan membangun pengetahuan mereka.

Pendekatan problem posing merupakan suatu pendekatan yang dapat

membentuk pola pikir siswa dalam menyelesaikan soal. Pendekatan ini akan

memberikan tantangan kepada siswa untuk berpikir lebih kreatif dalam

membuat dan menyelesaikan soal. Oleh karena itu, dengan pendekatan

problem posing ini diharapkan kemampuan berpikir siswa dapat berkembang.

Peneliti bermaksud meneliti bagaimana upaya meningkatkan prestasi

siswa dalam pembelajaran PLC melalui pendekatan Problem Posing pada

siswa SMKN2 Wonosari.

B. Identifikasi Masalah

Berdasar latar belakang masalah yang telah diuraikan di atas, dapat

diidentifikasi beberapa masalah sebagai berikut :

1. Keberanian siswa dalam bertanya jika belum memahami materi yang

diajarkan masih rendah.

2. Keberanian siswa dalam memberikan tanggapan atau mengungkapkan

pendapatnya masih rendah.

3. Siswa kurang tertarik dan kurang memberikan respon positif terhadap

pembelajaran yang diterapkan.
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4. Siswa mengalami kesulitan dalam mengerjakan soal-soal yang diberikan

karena siswa cenderung menghafalkan bentuk gambar laeder diagram

tanpa tahu bagaimana cara kerjanya.

5. Metode yang digunakan dalam pembelajaran PLC kurang bervariasi.

6. Tingkat prestasi siswa dalam pembelajaran PLC masih rendah atau

kurang dari KKM.

C. Batasan Masalah

Berdasarkan identifikasi masalah diatas, maka penelitian ini

mengambil beberapa masalah yang ada dalam identifikasi masalah yaitu

permasalahan tentang metode yang kurang bervariasi dan peningkatan

prestasi siswa.

D. Rumusan Masalah

Berdasarkan latar belakang dan identifikasi masalah yang telah

diuraikan diatas, maka dapat dirumuskan masalah sebagai berikut :

1. Apakah dengan pendekatan problem posing aktivitas belajar siswa

terhadap pembelajaran PLC meningkat?

2. Bagaimana peningkatan prestasi siswa SMKN2 Wonosari terhadap

pembelajaran PLC melalui pendekatan problem posing?
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E. Tujuan Penelitian

Berdasarkan rumusan masalah diatas, maka tujuan dari penelitian

adalah sebagai berikut :

1. Mengetahui peningkatan aktivitas belajar siswa terhadap pembelajaran

PLC menggunakan pendekatan problem posing.

2. Mengetahui peningkatan prestasi siswa dalam pembelajaran PLC melalui

pendekatan Problem Posing.

F. Manfaat Penelitian

Manfaat penelitian ini adalah sebagai berikut :

1. Bagi siswa

Dapat menumbuhkan kemampuan siswa mengajukan masalah,

kemampuan memecahkan masalah, dan kemampuan komunikasi siswa

yang dapat melatih dan merangsang siswa untuk mengembangkan

kemampuan berfikirnya. Pendekatan problem posing ini diharapkan

dapat meningkatkan kemampuan berfikir dan prestasi siswa.

2. Bagi guru

Mendapatkan pengalaman langsung melakukan Penelitain

Tindakan Kelas (PTK) untuk meningkatkan kualitas pembelajaran dan

kemampuan guru dalam mengajar. Yang semula berperan menjadi

pemberi informasi menjadi berperan sebagai fasilitator dan mediator
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yang dinamis sehingga kegiatan belajar mengajar menjadi lebih efektif,

efisien, kreatif dan inovatif.

3. Bagi penulis

Dapat menambah pengetahuan dan pengalaman di bidang

pendidikan dan meningkatkan wawasan sebagai calon guru dimasa yang

akan datang.
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BAB II

KAJIAN PUSTAKA

A. Kerangka Teori

1. Belajar

Morgan (Sri Rumini, 2006 : 59) mengatakan bahwa belajar adalah

setiap perubahan yang relatif menetap dalam tingkah laku yang terjadi

sebagai suatu hasil dari latihan atau pengalaman. Sardiman (2011 : 20)

menerangkan bahwa belajar itu senantiasa merupakan perubahan tingkah laku

atau penampilan, dengan serangkaian kegiatan misalnya dengan membaca,

mengamati, mendengarkan, meniru dan lain sebagainya. Nana Sudjana (2009

: 28) menjelaskan Belajar adalah proses mereaksi terhadap semua situasi yang

ada di sekitar individu. Dari beberapa pendapat di atas dapat disimpulkan

bahwa belajar merupakan suatu proses perubahan perilaku yang dihasilkan

karena latihan atau pengalaman.

2. Prestasi Balajar

Anne Ahira (2009) menjelaskan prestasi belajar adalah tingkatan

keberhasilan siswa dalam memahami dan menguasai setiap materi pelajaran

dan membuktikan dengan satu hasil maksimal Winkel W.S (1983:67),

menyatakan prestasi belajar adalah keberhasilan usaha yang dicapai

seseorang setelah memperoleh pengalaman belajar atau mempelajari

sesuatu. Sedangakan prestasi belajar dalam Kamus Besar Bahasa Indonesia
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adalah "penguasaan pengetahuan atau keterampilan yang dikembangkan oleh

mata pelajaran, lazimnya ditunjukkan dengan nilai tes atau angka nilai yang

diberikan oleh guru. Dalam hal ini prestasi belajar merupakan perkembangan

siswa setelah ia mengikuti kegiatan belajar dalam waktu tertentu. Zaenal

Arifin mengemukakan prestasi belajar sebagai kemampuan, keterampilan dan

sikap seseorang dalam menyelesaikan satu hal (Zaenal Arifin 1990 : 3).

Prestasi belajar dapat diukur dengan penilaian. Penilaian atau evaluasi

pada dasarnya adalah memberikan pertimbangan atau harga atau nilai

berdasarkan kriteria tertentu (Nana Sudjana, 2009: 111). Pada umumnya

prestasi belajar dalam sekolah berbentuk pemberian nilai (angka) dari guru

kepada siswa sebagai indikasi sejauh mana siswa telah menguasai materi

pelajaran yang disampaikannya.

Benyamin Bloom (Nana Sudjana, 2010: 22) menjelaskan prestasi

belajar yang dicapai oleh siswa dapat dikelompokkan menjadi tiga aspek

yaitu kognitif, afektif, dan psikomotorik.

a. Aspek kognitif

1) Ingatan yaitu  kemampuan seseorang untuk mengingat. Ditandai

dengan kemampuan menyebutkan simbol, istilah, definisi, fakta,

aturan, urutan, metode.

2) Pemahaman yaitu kemampuan seseorang untuk memahami tentang

sesuatu hal. Ditandai dengan kemampuan menerjemahkan,

menafsirkan, memperkirakan, menentukan, menginterprestasikan.
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3) Penerapan yaitu kemampuan berpikir untuk menjaring & menerapkan

dengan tepat tentang teori, prinsip, simbol pada situasi baru/nyata.

Ditandai dengan kemampuan menghubungkan, memilih,

mengorganisasikan, memindahkan, menyusun, menggunakan,

menerapkan, mengklasifikasikan, mengubah struktur.

4) Analisis Kemampuan berfikir secara logis dalam  meninjau  suatu

fakta/ objek menjadi lebih rinci. Ditandai dengan kemampuan

membandingkan, menganalisis, menemukan, mengalokasikan,

membedakan, mengkategorikan.

5) Sintesis Kemampuan berpikir untuk memadukan konsep-konsep

secara logis sehingga menjadi suatu pola yang baru. Ditandai dengan

kemampuan mensintesiskan, menyimpulkan, menghasilkan,

mengembangkan, menghubungkan, mengkhususkan.

6) Evaluasi Kemampuan berpikir untuk dapat memberikan pertimbangan

terhadap sustu situasi, sistem nilai, metoda, persoalan dan

pemecahannya dengan menggunakan tolak ukur tertentu sebagai

patokan. Ditandai dengan kemampuan menilai, menafsirkan,

mempertimbangkan dan menentukan.

b. Aspek Afektif

Aspek  afektif tidak dapat diukur seperti halnya ranah kognitif,

karena dalam ranah afektif kemampuan yang diukur merupakan.

1) Menerima (memperhatikan), meliputi kepekaan terhadap kondisi,

gejala,  kesadaran, kerelaan, mengarahkan perhatian
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2) Merespon,  meliputi merespon secara  diam-diam, bersedia merespon,

merasa  puas  dalam merespon, mematuhi peraturan

3) Menghargai, meliputi menerima suatu nilai, mengutamakan suatu

nilai, komitmen terhadap nilai

4) Mengorganisasi, meliputi mengkonseptualisasikan nilai, memahami

hubungan abstrak, mengorganisasi sistem suatu nilai

5) Karakteristik suatu nilai, meliputi falsafah hidup dan sistem nilai yang

dianutnya

c. Penilaian Psikomotorik

Psikomotorik meliputi (1) gerak refleks, (2) gerak dasar fundamen,

(3) keterampilan perseptual, diskriminasi kinestetik, diskriminasi visual,

diskriminasi auditoris, diskriminasi taktis, keterampilan perseptual yang

terkoordinasi, (4) keterampilan fisik, (5) gerakan terampil, (6) komunikasi

non diskusi (tanpa bahasa-melalui gerakan) meliputi: gerakan ekspresif,

gerakan interprestatif.

Sumadi Suryabrata menyatakan (Sumadi Suryabrata, 2002 : 23).

prestasi belajar dipengaruhi oleh faktor-faktor yang meliputi :

a. faktor yang berasal dari luar diri pelajar yang meliputi faktor non sosial

dan faktor-faktor sosial,

b. faktor yang berasal dari dalam diri pelajar yang meliputi faktor

fisiologis dan faktor-faktor psikologis
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Slameto (Slameto, 1995 : 56) menyatakan bahwa faktor-faktor

yang mempengaruhi prestasi belajar banyak jenisnya, tetapi dapat

digolongkan menjadi dua yaitu faktor internal dan faktor eksternal.

a. Faktor intern meliputi:

1) faktor Jasmaniah terdiri atas faktor kesehatan dan cacat tubuh

2) faktor psikologis terdiri atas intelegensi, perhatian, minat, bakat

motif, kematangan dan kelelahan

b. Faktor ekstern meliputi:

1) faktor keluarga terdiri atas cara orang tua mendidik, relasi antar

anggota keluarga, suasana rumah tangga dan keadaan ekonomi

keluarga.

2) faktor sekolah terdiri atas metode mengajar, kurikulum, relasi guru

dengan siswa, disiplin sekolah, keadaan gedung, dan tugas belajar.

3) faktor masyarakat terdiri atas kegiatan siswa dalam masyarakat,

mass media, teman bergaul, bentuk kehidupan masyarakat.

3. Aktivitas Belajar

Paul B. Diedrich (Sardiman 2011 : 101) membagi delapan aktivitas

dalam belajar, yakni:

a. Visual activities, yang termasuk di dalamnya misalnya, membaca,

memperhatikan gambar demonstrasi, percobaan, pekerjaan orang lain.
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b. Oral activities, seperti: menyatakan, merumuskan, bertanya, memberi

saran, mengeluarkan pendapat, mengadakan wawancara, diskusi

interupsi.

c. Listening activities, sebagai contoh mendengarkan: uraian, percakapan,

diskusi, musik, pidato.

d. Writing activities, seperti misalnya menulis cerita, karangan, laporan,

angket, menyalin.

e. Drawing activities, misalnya: menggambar, membuat grafik, peta,

diagram.

f. Motor activities, yang termasuk didalamnya antara lain: melakukan

percobaan, membuat konstruksi, model, mereparasi, bermain, berkebun,

berternak.

g. Mental activities, sebagai contoh misalnya: menanggapi, mengingat,

memecahkan soal, menganalisis, melihat hubungan, mengambil

keputusan.

h. Emotional activities, seperti misalnya, menaruh minat, merasa bosan,

gembira, bersemangat, bergairah, berani, tenang, gugup.

Berdasarkan pengertian aktivitas di atas, peneliti berpendapat

bahwa dalam belajar sangat dituntut keaktifan siswa. Siswa yang lebih

banyak melakukan kegiatan sedangkan guru lebih banyak membimbing

dan mengarahkan. Tujuan pembelajaran tidak mungkin tercapai tanpa

adanya aktifitas siswa apalagi dalam pembelajaran PLC Siswa dituntut

untuk aktif dan mau mencoba mempraktekkan apa yang didapatnya

http://www.sekolahdasar.net/2011/09/hakekat-pendidikan-kewarganegaraan-pkn.html
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sehingga siswa  mampu memecahkan masalah baik individu maupun

dalam kelompok.

Dalam penelitian ini aktivitas yang diamati meliputi visual

activities, oral activities, listening activities, writing activities, drawing

activities, motor activities, mental activities dan emotional activities.

4. Pendekatan Problem Posing

Pendekatan Problem Posing merupakan salah satu proses

pembelajaran yang berbasis konstruktif. Problem posing adalah istilah asing

yang  memiliki padanan kata dalam bahasa Indonesia adalah pengajuan

masalah. Problem posing dapat juga diartikan membangun atau membentuk

permasalahan. Herdian (2009) menyatakan problem posing merupakan model

pembelajaran yang mengharuskan siswa menyusun sendiri atau memecahkan

suatu masalah menjadi pertanyaan-pertanyaan yang lebih sederhana dan

mengacu pada penyelesaian soal tersebut. Kasiati (2008) problem posing

adalah pembelajaran yang menekankan siswa untuk membentuk atau

membuat soal.

Dari uraian yang telah dikemukakan di atas maka dirumuskan

pengertian problem posing adalah perumusan atau pembutan masalah sendiri

oleh siswa berdasarkan stimulus yang diberikan.

Pengajuan masalah atau problem posing bukan suatu yang baru, hanya

karena proses ini dilakukan secara alami sehingga tidak terpola secara

khusus. Oleh sebab itu para guru dan pengamat kadang tidak menyadari
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bahwa model pengajuan masalah (problem posing) menempati posisi yang

strategis dalam upaya meningkatkan kemampuan peserta didik dalam

menyelesaikan soal-soal. Siswa hanya diberikan situasi tertentu sebagai

stimulus dalam masalah baru. Kemudian informasi yang ada diolah dalam

pikiran dan setelah paham, siswa akan dapat membuat soal, sehingga

menyebabkan terbentuknya pemahaman yang lebih mantap pada diri siswa.

Kegiatan itu akan membuat siswa secara aktif mengkonstruksi hasil

belajarnya.

Silver dan Cai (1996 ) menjelaskan bahwa pengajuan soal mandiri

dapat diaplikasikan dalam 3 bentuk aktivitas kognitif yakni sebagai berikut:

a. Pre Solution Posing

Pre Solution Posing yaitu jika seorang siswa membuat soal dari situasi

yang diadakan. Jadi, guru diharapkan mampu membuat pertanyaan

yang berkaitan dengan pernyataan yang dibuat sebelumnya.

b. Within Solution Posing

Within Solution Posing yaitu jika seorang siswa mampu merumuskan

ulang pertanyaan soal tersebut menjadi sub-sub pertanyaan baru yang

urutan penyelesaiannya seperti yang telah diselesaikan sebelumnya.

Jadi, diharapkan siswa mampu membuat sub-sub pertanyaan baru dari

sebuah pertanyaan yang ada pada soal yang bersangkutan.
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c. Post Solution Posing

Post Solution Posing yaitu jika seorang siswa memodifikasi tujuan atau

kondisi soal yang sudah diselesaikan untuk membuat soal yang baru

yang sejenis.

Dalam penelitian ini peneliti akan menggunakan model pembelajaran

problem posing bentuk post solution posing.

Menurut Killpatrich (dalam Silver dan Cai, 1996:530) salah satu dasar

kognitif yang ada dalam problem posing adalah asosiasi. Selanjutnya,

menurut Suparno dalam Abdussakir (2009) menyatakan bahwa

mengungkapkan pertanyaan merupakan salah satu kegiatan yang menantang

siswa untuk lebih berfikir dn membangun pengetahuan mereka.

Disamping itu, Walter dan Brown (2005:12) menyatakan bahwa

problem posing mempunyai dua cara pandang, yaitu accepting (menerima)

dan challenging (menantang). Menerima terjadi ketika siswa membaca situasi

atau informasi yang diberikan guru dan menantang ketika siswa berusaha

mengajukan masalah sesuai dengan situasi atau informasi yang diberikan.

Siswa harus menguasai materi dan urutan penyelesaian soal secara mendetail.

Hal tersebut akan dicapai jika siswa memperkaya pengetahuannya tidak

hanya dari guru melainkan perlu belajar secara mandiri.

Peranan Problem posing dalam pembelajaran PLC, merupakan salah

satu pendekatan pembelajaran yang efektif untuk mengembangkan

keterampilan dan kemanpuan siswa. Karena sesuai dengan pembelajaran dan

pengembangan PLC. Banyak pengembangan PLC terjadi karena pengajuan
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masalah. Sehingga dapat disimpulkan bahwa pembentukan soal penting

dalam pembelajaran guna meningkatkan prestasi belajar PLC dengan

membuat siswa aktif dan kreatif.

Langkah-langkah pembelajaran dengan pendekatan problem posing

secara garis besar tercantum dalam tabel berikut (Iskandar, 2004).

Tabel 1 Langkah-langkah pembelajaran dengan pendekatan
problem posing

No. Kegiatan Pembelajaran
1.
2.
3.
4.
5.

6.

7.
8.

9.

10.
11.
12.

Membuka kegiatan pembelajaran.
Menyampaikan tujuan pembelajaran.
Memberikan materi pelajaran.
Memberikan contoh soal (merumuskan soal).
Memberikan kesempatan kepada siswa untuk bertanya hal-hal yang
belum jelas.
Memberikan kesempatan kepada siswa untuk merumuskan soal dari
suatu situasi yang diberikan, serta mendiskusikan/mempresentasikan.
Mempersilahkan siswa menyelesaikan soal yang telah dirumuskan.
Sebagai latihan, memberikan situasi tugas yang lain dan siswa
diberikan kesempatan untuk merumuskan soal sebanyak mungkin,
serta berdiskusikan dengan teman.
Mempersilakan siswa untuk saling menukar hasil rumusan soalnya dan
menyelesaikan soal temannya.
Mengarahkan siswa untuk membuat kesimpulan.
Membuat rangkuman berdasar kesimpulan yang dibuat siswa.
Menutup kegiatan belajar.

5. Kurikulum Tingkat Satuan Pendidikan (KTSP)

Kurikulum Tingkat Satuan Pendidikan (KTSP) adalah kurikulum

operasional yang disusun dan dilaksanakan di masing-masing satuan

pendidikan. KTSP terdiri dari tujuan pendidikan tingkat satuan pendidikan,

struktur dan muatan kurikulum tingkat satuan pendidikan, kalender

pendidikan, dan silabus.
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a. Tujuan pendidikan tingkat satuan pendidikan

Tujuan satuan pendidikan harus berorientasi pada tujuan pendidikan dasar,

visi, dan misi sekolah.

b. Struktur dan muatan kurikulum tingkat satuan pendidikan

Struktur kurikulum adalah pola dan susunan mata pelajaran yang harus

ditempuh oleh peserta didik dalam kegiatan pembelajaran. Kedalaman

muatan kurikulum pada setiap mata pelajaran pada setiap satuan

pendidikan dituangkan dalam kompetensi yang harus dikuasai peserta

didik sesuai dengan beban belajar yang tercantum dalam struktur

kurikulum.

Muatan kurikulum meliputi: mata pelajaran, muatan lokal, pengembangan

diri, pengaturan beban belajar, kriteria ketuntasan belajar, ketentuan

mengenai kenaikan kelas dan kelulusan, pendidikan kecakapan hidup, dan

pendidikan berbasis keunggulan lokal dan global.

c. Kalender pendidikan

Kalender pendidikan adalah pengaturan waktu untuk kegiatan

pembelajaran peserta didik selama satu tahun ajaran. Sedangkan

komponen kalender pendidikan adalah permulaan tahun pelajaran, minggu

efektif belajar, waktu pembelajaran efektif, dan waktu libur.

d. Silabus

Silabus adalah rencana pembelajaran pada suatu dan/atau kelompok mata

pelajaran/tema tertentu yang mencakup standar kompetensi, kompetensi

dasar, materi pokok/pembelajaran, kegiatan pembelajaran, indikator,
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penilaian, alokasi waktu, dan sumber/bahan/alat belajar. Silabus

merupakan penjabaran standar kompetensi dan kompetensi dasar ke dalam

materi pokok/pembelajaran, kegiatan pembelajaran, dan indikator

pencapaian kompetensi untuk penilaian.

Tabel 2 Standar Kompetensi dan Kompetensi Dasar Mata
Pelajaran PLC

Standar Kompetensi Kompetensi Dasar

Mengoperasikan mesin produksi
dengan kendali PLC

Mempersiapkan operasi

Melaksanakan operasi

Mengamati dan menangani
masalah operasi

Membuat laporan pengoperasian

6. Materi Pembelajaran PLC

a. Definisi PLC

Menurut Iwan Setiawan (2006:1) PLC adalah sebuah komputer

yang dirancang untuk mengontrol suatu proses atau mesin. Sedangkan

menurut William Bolton (2003:3) mendefinisikan PLC sebagai suatu

khusus pengontrol berbasis mikroprosesor yang memanfaatkan memori

yang dapat diprogram untuk menyimpan instruksi-instruksi dan untuk

mengimplementasikan fungsi-fungsi semisal logika (sequencing),

pewaktuan (timing), pencacah (counting)  dan aritmatika guna

mengontrol mesin-mesin dan proses-proses dan di rancang untuk
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dioperasikan oleh para insinyur yang hanya memiliki sedikit

pengetahuan mengenai komputer dan bahasa perograman.

b. Sejarah PLC

Pertama kali diperkenalkan pada tahun 1968. PLC dibuat

untuk mengurangi beban ongkos perawatan dan penggantian sistem

kontrol mesin yang menggunakan relai. Semakin banyaknya kebutuhan

dalam proses produksi menyebabkan sistem harus diubah-ubah.

Apabila sistem yang digunakan merupakan relai mekanik, tentu saja hal

itu akan menjadi masalah yang besar. Selain masa penggunaanya

terbatas, sistem juga membutuhkan perawatan yang cermat. Jika terjadi

kerusakan maka akan sangat sulit untuk menemukannya. Oleh sebab itu

dalam waktu singkat penggunaan PLC mulai menyebar ke industri-

industri lain. Pada tahun 1971, PLC mulai digunakan untuk

menggantikan relai pada industri-industri seperti: industri makanan dan

minuman, industri pengolahan metal, industri manufaktur, dan industri

pulp dan kertas.

Kemampuan PLC terus dikembangkan hingga sekarang. PLC

saat ini mempunyai scan times yang lebih cepat karena menggunakan

teknologi mikroprosesor yang lebih maju. Kemampuan input-output

nya juga meningkat menjadi lebih hemat ruang dan berbiaya lebih

rendah. Walaupun kemampuan PLC terus meningkat sehingga

mempunyai scan times yang lebih cepat, tipe-tipe antarmuka yang lebih

bervariasi, kemampuan memproses data yang lebih canggih, namun



21

spesifikasi PLC tetap mempertahankan tujuan awal penciptanya, yaitu

mudah untuk digunakan dan dipelihara.

c. Prinsip Kerja PLC

Secara umum, PLC terdiri dari dua komponen penyusun utama

yaitu Central Processing Unit (CPU) dan Sistem antarmuka

input/output

Gambar 1 Blok diagram PLC

Pada dasarnya, operasi PLC sangat sederhana yaitu, peralatan

dari luar dikoneksikan dengan modul input dan output PLC yang

tersedia. Peralatan ini dapat berupa sensor-sensor analog, push button,

limit switch, motor, solenoid, lampu dan sebagainya. Selama prosesnya

CPU melakukan tiga operasi utama : (1) membaca data masukan dari

perangkat luar via modul input, (2) mengeksekusi program kontrol yang

tersimpan di memori PLC, (3) meng-update atau memperbaharui data

pada modul output (Iwan Setiawan 2006 : 7).
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d. Koneksi Peralatan dengan Modul input PLC

Peralatan input adalah yang memberikan sinyal kepada PLC

dan selanjutnya PLC memproses sinyal tersebut untuk mengendalikan

peralatan output. Peralatan input itu antara lain:

1. berbagai jenis saklar, misalnya tombol, saklar togel, saklar batas,

saklar level, saklar tekan, saklar proximity,

2. berbagai jenis sensor, misalnya sensor cahaya, sensor suhu, sensor

level.

e. Koneksi Peralatan dengan Modul output PLC

Sistem otomasi tidak lengkap tanpa ada peralatan output yang

dikendalikan. Peralatan output itu misalnya:

1. kontaktor,

3. motor listrik,

4. lampu,

5. buzer

f. Keunggulan Sistem Kendali PLC

Sistem kendali PLC memiliki banyak keunggulan

dibandingkan dengan sistem kendali elektromagnetik sebagai berikut:

1. pengawatan sistem kendali PLC lebih sedikit,

2. modifikasi sistem kendali dapat dengan mudah dilakukan dengan

cara mengganti progam kendali tanpa merubah pengawatan sejauh

tidak ada tambahan peralatan input/output,
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3. tidak diperlukan komponen kendali seperti timer dan hanya

diperlukan sedikit kontaktor sebagai penghubung peralatan output

ke sumber tenaga listrik,

4. kecepatan operasi sistem kendali PLC sangat cepat sehingga

produktivitas meningkat,

6. biaya pembangunan sistem kendali PLC lebih murah dalam kasus

fungsi kendalinya sangat rumit dan jumlah peralatan

input/outputnya sangat banyak,

7. sistem kendali PLC lebih andal,

8. program kendali PLC dapat dicetak dengan cepat.

g. Bahasa Pemrograman PLC

Menurut IEC (International Electrical Commission) dalam

(Iwan Setiawan 2006:9) terdapat lima bahasa pemrograman PLC

1. list instruksi (Instruction List) – Pemrograman dengan

menggunakan instruksi-instruksi bahasa level rendah (Mnemonic),

seperti LD/STR, NOT, AND dan lain sebagainya.

2. diagram ladder (Ladder Diagram) – pemrograman berbasis logika

relai, cocok digunakan untuk persoalan-persoalan kontrol diskret

yang input / output hanya memiliki dua kondisi ON atau OFF

seperti pada sistem kontrol konveyor, lift, dan motor-motor

industri.

3. diagram blok fungsional (functional Blok Diagram) –

pemrograman berbasis aliran data secara grafis. Banyak digunakan
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untuk tujuan kontrol proses yang melibatkan perhitungan-

perhitungan kompleks dan akuisisi data analog.

4. diagram fungsi Sekuensial (Sequensial Fungtion Charts) – metode

grafis untuk pemrograman terstruktur yang banyak melibatkan

langkah-langkah rumit, seperti pada bidang robotika, perakitan

kendaraan, Batch Control, dan lain sebagainya.

5. teks terstruktur (Structured Text) – tidak seperti keempat metode

sebelumnya, pemrograman ini menggunakan statemen-statemen

yang umum dijumpai pada bahasa level tinggi (high level

programming) seperti If/Then, Do/While, Case, For/Next, dan lain

sebagainya.

h. Perangkat Pemrograman

Pada dasarnya PLC dapat diprogram menggunakan dua

perangkat pemrograman yang biasa digunakan:

- Miniprogrammer atau Console

Miniprogrammer adalah sebuah perangkat yang berfungsi untuk

memasukkan instruksi-instruksi ke dalam PLC. Umumnya

instruksi-instruksi yang biasa digunakan dalam miniprogrammer

adalah mnemonic. Menggunkan  miniprogrammer akan melelahkan

saat program yang panjang dan rumit.

- Personal Computer

Untuk pemrograman yang lebih banyak dan rumit, komputer

menjadi pilihan yang lebih mudah karena pada umumnya vendor-
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vendor PLC menyertakan perangkat lunak PC yang dapat

digunakan untuk memasukkan program, pengeditan, dokumentasi,

dan memonitor PLC secara real time. Banyak juga perangkat lunak

PLC yang dilengkapi simulasi yang di simbolkan dalam bentuk

gambar atau visual. Hal ini membuat pemrograman PLC menjadi

lebih mudah dan menarik.

B. Penelitian yang Relevan

Penelitian yang dilakukan Dwi Hesti Hartini tahun 2010 tentang “

Peningkatan Kemampuan Berfikir Kritis Siswa dalam Pembelajaran

Matematika melalui Pendekatan Problem Posing pada Siswa Kelas VII SMP

Negeri 3 Klaten”. Menunjukkan bahwa pembelajaran matematika melalui

pendekatan problem posing dapat meningkatkan kemampuan berfikir kritis

siswa kelas VII C SMP Negeri 3 Klaten. Hal ini ditujnjukkan oleh sebanyak

24 siswa atau 64,86% dari jumlah siswa mengalami peningkatan kemampuan

berfikir kritis berdasar skor total aspek kemampuan berfikir kritis.

Penelitian yang dilakukan Bekti Maryuni Susanto tahun 2010 tentang

“Peningkatan Hasil Belajar Siswa pada Mata Diklat Memahami Dasar-Dasar

Elektronika melalui Penerapan Model Pembelajaran Kooperatif Think Pair

Share di SMK N 2 Wonosari”. Pada penelitian ini menunjukkan peningkatan

hasil belajar siswa dari 62,5% siswa yang mencapai KKM pada siklus

pertama menjadi 100% di siklus yang kedua.



26

Penelitian yang dilakukan oleh Erna Risfaula Kusumawati tahun 2008

tentang “Penerapan pendekatan problem posing untuk meningkat prestasi

belajar fisika dan kemampuan berpikir (Thinking Skill) siswa SMAN 7

Malang kelas XI pokok bahasan fluida statis”. Menunjukkan bahwa prestasi

belajar fisika melalui pendekatan problem posing yang telah dilaksanakan

pada kelas sampel yang diajar dengan pendekatan problem posing memiliki

rata-rata prestasi belajar 87,4 dan persentase kemampuan berpikir 75 %

sedangkan kelas sampel yang diajar dengan metode konvensional memiliki

rata-rata prestasi belajar 76,3 dan persentase kemampuan berpikir 60 %.

C. Kerangka Berfikir

Problem posing adalah salah satu pendekatan yang dapat melibatkan

siswa secara aktif untuk menganalisa sebuah situasi tertentu menjadi sebuah

informasi yang akan membangun pengetahuannya. Siswa tidak hanya

menerima pengetahuan dari guru saja tapi juga aktif mengkonstruksi

pengetahuan tersebut secara individual. Pendekatan ini merupakan

pendekatan pembelajaran yang mendorong siswa untuk membuat soal sendiri

dan menyelesaikannya.

Pada dasarnya setiap siswa mempunyai rasa ingin tahu dan daya

imajinasi. Rasa  inilah yang mengembangkan kemampuan untuk

menganalisis, mengevaluasi informasi yang diterima. Untuk mengembangkan

kemampuan ini, siswa diajak untuk dapat berfikir lebih aktif. Pendidik

perlu menggunakan pendekatan atau strategi pembelajaran yang dapat tepat

dan efektif untuk dapat meningkatkan prestasi belajar.
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D. Hipotesis Tindakan

Hipotesis tindakan dalam penelitian ini adalah adanya peningkatan

prestasi belajar siswa kelas XI EI SMKN 2 Wonosari dalam pembelajaran

PLC setelah mengikuti pembelajaran PLC melalui pendekatan problem

posing.
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BAB III

METODE PENELITIAN

A. Jenis Penelitian

Jenis penelitian yang dilakukan adalah Penelitian Tindakan Kelas

(PTK) model Kemmis Mc Taggart dengan penerapan pembelajaran problem

posing pada siswa kelas XI EI SMKN 2 Wonosari. Tindakan yang

direncanakan berupa penerapan pembelajaran melalui pendekatan problem

posing guna meningkatkan prestasi belajar dan aktivitas siswa dalam

pembelajaran PLC.

B. Model Penelitian

Penelitian tindakan kelas yang digunakan dalam penelitian ini

mengacu pada pendekatan yang dikemukakan oleh Suharsimi Arikunto

(2008:16) dalam buku Penelitian Tindakan Kelas. Terdiri dari empat langkah

kesatuan yang dilakukan berulang yaitu perencanaan, pelaksanaan,

pengamatan dan refleksi.

C. Subyek dan Obyek Penelitian

Subyek dalam penelitian ini adalah siswa kelas XI EI SMKN 2

Wonosari tahun ajaran 2011/2012. Obyek dalam penelitian ini adalah

keseluruhan proses dan hasil pembelajaran PLC melalui pendekatan problem
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posing di kelas XI EI SMKN 2 Wonosari dalam upaya meningkatkan prestasi

belajar siswa.

D. Tempat dan Waktu Penelitian

Penelitian ini mulai dilaksanakan pada awal semester genap tahun

pelajaran 2011/2012, yakni pada bulan Januari 2012. Sedangkan

pengambilan data dilaksanakan pada tanggal 23 Januari – 27 Februari 2012.

Dengan menyesuaikan jadwal jam pelajaran PLC di kelas tersebut. Tempat

pelaksanaan penelitian di SMKN 2 Wonosari yang beralamat di jl. KH. Agus

Salim No.17, Wonosari, Gunungkidul.

E. Setting Penelitian dan Sumber Data

Setting penelititan ini menggunakan setting penelitian kelas. Kelas

yang digunakan adalah kelas XI EI SMKN 2 Wonosari. Sumber data dalam

penelitian ini adalah siswa, guru, yang didukung dengan lembar observasi,

catatan lapangan, dan hasil tes.

F. Instrumen Penelitian

Instrumen penelitian yang digunakan dalam penelitian ini adalah

lembar observasi, pedoman wawancara, angket dan tes hasil belajar.

1. Lembar observasi

Lembar observasi digunakan peneliti sebagai pedoman untuk

melakukan observasi guna memperoleh data yang akurat dalam

pembelajaran. Lembar observasi yang digunakan adalah lembar observasi
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dengan pendekatan problem posing. Lembar ini juga digunakan untuk

memonitor dan mengevaluasi setiap tindakan agar kegiatan observasi tidak

terlepas dari konteks permasalahan dan tujuan penelitian. Lembar

observasi yang digunakan dalam penelitian ini adalah lembar observasi

keterlaksanaan pembelajaran dan lembar observasi aktivitas siswa. Lembar

observasi dibuat berdasar langkah-langkah pembelajaran PLC dengan

pendekatan problem posing. Langkah-langkah pembelajaran dengan

pendekatan problem posing dapat dilihat di bab sebelumnya.

2. Tes Prestasi Belajar

Tes pada penelitian ini berupa soal uraian yang diberikan pada

akhir setiap siklus dan berpedoman pada indikator keberhasilan untuk

meningkatkan prestasi belajar siswa. Hasil tes akan dianalisis guna

mengetahui peningkatan prestasi siswa setelah melakukan pembelajaran

PLC dengan pendekatan problem posing. Jumlah soal tes untuk siklus I

terdiri dari sembilan butir dan jumlah soal tes pada siklus II terdiri dari

sembilan butir soal.

G. Teknik Pengumpulan Data

Teknik pengumpulan data dalam penelitian ini adalah

1. Observasi

Observasi dilakukan oleh peneliti dengan cara melakukan

pengamatan dan pencatatan selama proses pembelajaran dikelas tanpa

mengganggu pembelajaran. Observasi bertujuan untuk mengamati proses



31

pelaksanaan pembelajaran PLC dengan pendekatan problem posing.

Observasi dengan pendekatan problem posing yakni siswa membuat soal

berdasarkan stimulus yang diberikan oleh guru kemudian

menyelesaikannya berdasar contoh dari guru (Post Solution Posing).

Observasi dilakukan dengan menggunakan lembar observasi yang telah

dipersiapkan.

2. Tes

Tes digunakan untuk mengetahui bagaimana siswa menyelesaikan

permasalahan yang diberikan dengan pendekatan problem posing. Tes ini

dikerjakan oleh siswa secara individu setelah mempelajari materi. Tes

diberikan dalam bentuk uraian dan satu tugas membuat soal beserta

penyelesaianya.

H. Rancangan Penelitian

Penelitian ini dilaksanakan dalam beberapa siklus yaitu dimulai deri

perencanaan, pelaksanaan tindakan, observasi, refleksi dan selanjutnya

dilakukan kembali dengan perencanaan tindakan berikutnya. Secara rinci

langkah-langkah dalam setiap siklus dijabarkan berikut ini.

1. Siklus I

a. Perencanaan

Pada tahap ini peneliti merancang tindakan yang dilaksanakan.

1) Menyusun Rencana Pelaksanaan Pembelajaran (RPP) sesuai dengan

materi yang akan diajarkan melalui pendekatan problem posing.
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Rencana pelaksanaan pembelajaran disusun oleh peneliti dengan

pertimbangan dari dosen dan guru sebagai pedoman guru dalam

melaksanakan pembelajaran di kelas.

2) Menyusun dan mempersiapkan materi pembelajaran yang akan

digunakan dalam setiap proses pembelajaran dan lembar tugas

membuat soal. Lembar tugas membuat soal akan disusun dengan

memperhatikan pertimbangan dari guru PLC kelas XI EI SMKN 2

Wonosari.

3) Mempersiapkan contoh-contoh soal siklus I.

4) Menyusun dan menyiapkan lembar observasi pelaksanaan

pembelajaran dan lembar observasi aktivitas siswa selama mengikuti

pembelajaran dengan pendekatan problem posing.

5) Mempersiapkan soal tes siklus I. Soal tes disusun oleh peneliti

dengan pertimbangan dosen pembimbing dan guru PLC yang

bersangkutan.

b. Pelaksanaan Tindakan

Pada tahap tindakan guru melaksanakan rancangan

pembelajaran PLC melalui pendekatan problem posing yang telah

direncanakan yaitu berdasar rencana pelaksanaan pembelajaran yang

telah disiapkan. Sementara itu, peneliti bersama pengamat lain

mengamati aktivitas dan perilaku siswa pada saat pembelajaran di

kelas. Rencana kegiatan yang dilakukan bersifat fleksibel dan terbuka

terhadap perubahan-perubahan, sesuai dengan kegiatan yang ada
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selama proses pelaksanaan di lapangan. Pada siklus ini tindakan yang

dilakukan adalah.

1) Guru memberikan apersepsi yang berkaitan dengan materi pelajaran.

2) Guru menjelaskan materi pelajaran secara singkat.

3) Menyajikan materi pelajaran dengan strategi yang sesuai dan

berusaha selalu melibatkan siswa dalam pembelajaran, kemudian

guru memberikan contoh-contoh mengerjakan latihan soal.

4) Guru menyajikan soal yang berhubungan dengan materi yang

diajarkan, kemudian siswa diminta untuk mengerjakan soal tersebut.

Setelah selesai, guru meminta siswa untuk membuat soal baru yang

sejenis kemudian menyelesaikannya.

5) Siswa membuat permasalahan beserta penyelesaiannya yang

dikerjakan secara individu sesuai dengan materi yang diajarkan,

kemudian siswa menuliskan permasalahan dan penyelesaian yang

telah dibuatnya di papan tulis. Siswa lain menanggapi permasalahan

dan menyelesaikan soal yang telah dibuat oleh temannya.

6) Siswa bersama-sama dengan guru membuat kesimpulan terhadap

materi yang telah dipelajari.

7) Guru memberikan evaluasi di akhir pelajaran.

c. Observasi

Observasi dilakukan selama pelaksanaan tindakan sebagai

upaya untuk mengetahui jalanya pembelajaran. Observasi adalah

pengamatan yang dilakukan peneliti dibantu oleh pengamat lain yang
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turut mengamati pelaksanaan tindakan dengan menggunkan pedoman

observasi yang telah dipersiapkan. Pada tahap ini, dilakukan observasi

terhadap semua proses tindakan, hasil tindakan, situasi tempat tindakan

dan kendala-kendala tindakan. Peneliti berada di kelas yang sama

mengamati dan mencatat segala sesuatu yang terjadi pada saat

pembelajaran di kelas. Dalam hal ini untuk mengetahui kesesuaian

pelaksanaan tindakan dengan rencana tindakan yang telah disusun

sebelumnya.

d. Refleksi

Data yang diperoleh pada tahap observasi di analisis. Masalah

yang muncul, kekurangan-kekurangan dan segala hal yang berkaitan

dengan tindakan yang telah dilakukan kemudian dilakukan refleksi.

Sebagai pertimbangan perencanaan pada pembelajaran siklus

berikutnya. Pelaksanaan refleksi berupa diskusi antara guru PLC yang

bersangkutan dengan peneliti.

2. Siklus lanjutan

Kegiatan yang dilakukan pada siklus II dimaksudkan sebagai

perbaikan dari siklus I. Tahap kerja pada siklus II mengikuti tahapan kerja

pada siklus I yaitu diawali dengan perencanaan, pelaksanaan tindakan,

observasi dan refleksi. Siklus II, IV, V dan seterusnya masih terdapat

kemungkinan untuk dilaksanakan jika hasil dari siklus II masih terdapat

banyak kekurangan atau belum berhasil.
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I. Skenario Penelitian

Skenario penelitian ini berisi tindakan-tindakan yang akan dilakukan

di dalam kelas.

Tabel 3 Skenario Tindakan Penelitian

Kegiatan Guru dan Observer Kegiatan Siswa
1. Membuka pelajaran dengan

salam dan menginformasikan
tujuan pembelajaran
menggunakan pendekatan
problem posing.

Siswa memperhatikan.

2. Guru membagi siswa dalam
beberapa kelompok. Sementara
observer memulai mengisi lembar
keterlaksanaan pembelajaran dan
aktivitas siswa.

3. Guru menyajikan materi
pembelajaran PLC

Siswa memperhatikan.

4. Dengan tanya jawab membahas
kegiatan dengan menggunakan
pendekatan problem posing
dengan  memberikan contoh soal
dan cara membuat soal.

Berpartisipasi aktif dalam kegiatan.

5. Memberikan kesempatan pada
siswa untuk menanyakan hal-hal
yang kurang jelas.

Bertanya pada hal-hal yang belum
jelas.

6. Mengajak siswa membuat
permasalahan dari situasi yang
telah diberikan. Kegiatan
dilakukan

Merumuskan permasalahan
berdasarkan situasi yang diketahui
secara berkelompok

7. Mempersilahkan siswa untuk
menyelesaikan permasalahan
yang dibuatnya sendiri

Menyelesaikan permasalahan  yang
dibuatnya sendiri.

8. Mempersilahkan siswa untuk
membagi permasalahanya kepada
teman-teman yang lain

Mempresentasikan permasalahan
dan bagaiman cara
menyelesaikannya di depan kelas.

9. Mengarahkan siswa untuk
membuat kesimpulan dan
observer menghentikan kegiatan
mengisi lembar observasi.

Berusaha untuk dapat
menyimpulkan materi yang sudah
dipelajari.

10. Guru memberikan evaluasi Mengerjakan evaluasi
11. Guru menutup  kegiatan pelajaran
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J. Teknik Analisis Data

Teknik analisis data yang digunakan dalam penelitian ini adalah

sebagai berikut :

1. Analisis Data Observasi

Data hasil observasi keterlaksanaan pembelajaran menggunakan

pendekatan problem posing digunakan untuk mengetahui kesesuaian

pelaksanaan tindakan dengan  rencana tindakan yang telah disusun

sebelumnya.

Observasi aktivitas digunakan untuk mengamati aktivitas siswa di

kelas. Observasi yang digunakan dalam penelitian ini adalah penelitian

terstruktur menggunakan pedoman observasi yang terdiri dari delapan

aspek pengamatan. Data hasil aktivitas dianalisa secara deskriptif

persentase. Adapun langkah-langkah kualifikasinya adalah sebagai berikut.

a. Masing-masing siswa dikelompokkan menurut aktivitas yang diamati.

b. Kemudian dari jumlah siswa yang tercatat dihitung jumlah siswa yang

melakukan aktivitas tersebut. Hal ini digunakan untuk setiap aktivitas.

c. Dari jumlah siswa yang melakukan aktivitas pada setiap aktivitasnya

selanjutnya dihitung persentasenya menggunakan persamaan sederhana

menurut sutardi sebagai berikut (Daryanto, 2011 192).
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d. Dari hasil perhitungan tersebut, kemudian hasil dari siklus I dan siklus

II dibandingkan.

2. Analisis Hasil Tes

Analisis hasil tes siswa digunakan untuk mengetahui jumlah skor

siswa pada akhir siklus. Soal yang digunakan untuk mengukur

keberhasilan belajar siswa terdiri dari Sembilan soal uraian dengan skor

maksimum 100. Hasil belajar siswa akan dianalisis secara deskriptif.

Analisis deskriptif digunakan untuk mendiskripsikan atau memberikan

gambaran objek yang diteliti sebagaimana adanya. Dalam analisa

deskriptif ini dikemukakan cara-cara penyajian data dalam bentuk tabel,

penentuan rata-rata (mean), modus, median, rentang serta simpangan baku.

Adapun langkah-langkah pengolahan data adalah sebagai berikut.

a. Hasil tes dari setiap siswa dikumpulkan dan disajikan dalam bentuk

tabel.

b. Kemudian dari data hasil tes dicari rata-rata (mean), modus, median,

serta simpangan bakunya.

c. Untuk menentukan kategori skor digunakan pedoman pengkategorian

sebagai berikut Nana Sudjana ( 2010: 122 ).

Tabel 4 Kategorisasi hasil tes siswa

No Kategori Skor
1 Rendah M - 1.5 SD ≤ X <M - 0.5  SD
2 Sedang M - 0.5 SD ≤ X < M + 0.5 SD
3 Tinggi M + 0.5 SD ≤ X < M + 1.5 SD
4 Sangat Tinggi M + 1,5 SD ≤ X < M + 3.0 SD
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Keterangan :

- Mean ideal (M) :
2

1
(skor tertinggi + skor terendah)

- Standar Deviasi (SD) :
6

1
(skor tertinggi – skor terendah)

- X : Skor yang dicapai siswa

d. Dari setiap kategori hasil tes siswa dihitung prosentasenya.

e. Hasil persentase antara silklus I dan siklus II dibandingkan.

K. Indikator Keberhasilan

Peningkatan hasil belajar peserta didik ditandai dengan siswa

memberikan perhatian yang positif terhadap pembelajaran PLC

menggunakan pendekatan problem posing. Atau dengan kata lain siswa

menjadi lebih serius dan pandangan siswa tertuju pada guru saat guru

menjelaskan. Suasana menjadi kondusif, aktif mengerjakan tugas dan

semakin sedikit siswa yang melakukan gangguan belajar, misalnya :

melamun, mengantuk, sering ijin kebelakang dan lain-lain.

Peningkatan hasil belajar siswa juga ditandai dengan bertambahnya

keaktifan siswa bertanya baik kepada guru ataupun teman lain. Mempunyai

inisiatif bertanya kepada teman lain. Peningkatan hasil siswa dapat dilihat

dari hasil tes hasil belajar dari setiap siklus.
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BAB IV

HASIL PENELITIAN DAN PEMBAHASAN

A. Deskripsi Pelaksanaan Penelitian

Proses pembelajaran di SMKN 2 Wonosari dimulai pada pukul 07.00.

Proses pembelajaran dilakukan satu jam pelajaran masing-masing diberi

waktu 45 menit. Untuk pelajaran PLC dalam satu minggunya diberikan

alokasi waktu 6 jam pelajaran. Pembelajaran PLC dilaksanakan jam 12.45 –

02.15 pada hari senin dan jam 07.00 – 10.15 pada hari selasa.

Pengambilan data dalam penelitian ini dilaksanakan pada tanggal 26

Januari sampai tanggal 29 februari 2012. Pokok bahasan yang dibahas adalah

Pengendalian Mesin Produksi menggunkan PLC. Pelaksanaan pembelajaran

menggunakan problem posing dilakukan selama 2 siklus. Pada pembelajaran

siklus 1 materi yang diajarkan adalah penggunaan PLC dan logika dasar

seperti logika and, or, not, nand dan exor. Sedangkan pada pembelajaran

siklus ke 2 materi yang diajarkan adalah mendownload program ke PLC dan

aplikasi Timer dan Counter.

Adapun jadwal pelaksanaan penelitian disesuaikan dengan jadwal

pelajaran PLC di kelas XI EI, yaitu sebagai berikut.
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Tabel 5 Jadwal kegiatan Pembelajaran Kelas XI EI SMK N 2
Wonosari

Siklus Hari / Tanggal Waktu Materi

I

Senin / 6 Feb 2012 12.45 – 02.15 WIB - Pengenalan PLC
- logika dasar

Selasa / 7 Feb 2012 07.00 – 10.15 WIB - Praktek logika dasar
menggunakan simulasi Zelio

- Tes akhir Siklus I

II

Senin / 13 Feb 2012 12.45 – 02.15 WIB - download program ke PLC
menggunakan CX-Programmer

- Aplikasi timer - Counter
Selasa / 14 Feb 2012 07.00 – 02.15 WIB - Praktek Timer – Counter

- Tes akhir Siklus II

Pelaksanaan penelitian tindakan kelas pada siklus I dan siklus II

meliputi perencanaan, pelaksanaan tindakan dan observasi serta refleksi.

Deskripsi pelaksanaan tindakan kelas tentang pembelajaran PLC

menggunakan pendekatan problem posing pada siklus I dan siklus II sebagai

berikut:

1. Penelitian Tindakan Kelas Siklus I

a. Perencanaan

Kegiatan ini bertujuan untuk mempersiapkan segala sesuatu

sebelum pelaksanaan penelitian.

1) Penyusunan Perangkat Pembelajaran

Perangkat pembelajaran yang digunakan dalam penelitian ini

adalah:

a) Membuat Rencana Pelaksanaan Pembelajaran (RPP) mengenai

materi yang akan diajarkan dengan menggunkan pendekatan

problem posing.
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b) Membuat media yang digunakan dalam pembelajaran. Media

yang digunakan dalam penelitian ini contoh-contoh soal.

2) Penyusunan Instrument Penelitian

a) Menyiapkan soal tes siklus I yang diberikan pada akhir siklus.

b) Menyusun dan mempersiapkan lembar observasi dalam

pembelajaran. Lembar observasi yang digunakan dalam

penelitian ini ada dua macam yaitu

i) Lembar Observasi Keterlaksanaan Pembelajaran dengan

Pendekatan Problem Posing.

ii) Lembar Observasi Aktivitas Siswa dengan Pendekatan

Problem posing

b. Pelaksanaan Tindakan dan Hasil Observasi

1) Pertemuan Pertama

Pertemuan pertama dilaksanakan pada hari senin, 06

Februari 2012. Pada pertemuan pertama pelaksanaan pembelajaran

mata diklat PLC dengan menggunakan pendekatan problem posing,

guru memberikan petunjuk kepada siswa tentang bagaimana

mengajukan masalah atau soal.

Guru membagi siswa dalam 8 kelompok beranggotakan 4

orang sedangkan 1 kelompok lainnya beranggotakan 5 orang.

Kelompok ini dibagi menurut nomor absen siswa. Setiap siswa

dikondisikan untuk bekerja sama dengan  kelompok  untuk
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mengerjakan tugas dan mengajukan sebuah masalah selama waktu

yang telah ditentukan dan guru.

Selanjutnya pada kegiatan penutup, peneliti mengevaluasi

pelajaran dan memberikan kesempatan kepada siswa untuk

menanyakan hal-hal yang belum dimengerti. Adapun pelaksanaan

pembelajaran mata diklat PLC pada siklus I sebagai berikut:

a) Kegiatan Awal

i) Guru masuk kelas, memberi salam kemudian  dilanjutkan

mempresensi siswa   dan memastikan kondisi siswa untuk

siap memulai pelajaran yang akan disampaikan.

ii) Guru memberikan apersepsi yang berhubungan dengan

materi yang akan disampaikan agar mendapat respon dari

siswa.

b) Inti Pembelajaran

i) Guru memperkenalkan diri dan menyampaikan tujuan dari

penelitian yang dilakukan. Guru juga menjelaskan model

pembelajaran melalui pendekatan problem posing yang akan

diterapkan.

ii) Guru menyampaikan materi secara garis besar mengenai

pengenalan PLC dan logika dasar.

iii) Guru membagi siswa dalam kelompok-kelompok kecil

iv) Setelah semua kelompok terbentuk guru memberikan contoh-

contoh soal kepada setiap kelompok dan memberikan
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kesempatan kepada siswa untuk mengerjakan dan berdiskusi

dengan teman.

v) Guru mempersilahkan setiap kelompok untuk mengajukan

masalah dan menyelesaikannya sendiri.

vi) Salah satu kelompok mempresentasikan hasil pengajuan

masalah yang telah dibuat beserta penyelesaiannya.

c) Penutup

i) Guru mengajak siswa untuk mereview materi yang baru saja

disampaikan.

ii) Guru memberikan kesempatan kepada siswa untuk

menanyakan hal-hal yang masih kurang jelas.

iii) Guru memberi salam penutup memimpin berdoa dan keluar

meninggalkan kelas.

2) Pertemuan Kedua

Pertemuan kedua dilaksanakan pada hari selasa, 07 Februari

2012. Pada pertemuan kedua ini pembelajaran mata diklat PLC

difokuskan untuk mempraktekkan logika-logika dasar.

a) Kegiatan Awal

i) Guru masuk kelas, memberi salam, memimpin doa, kemudian

dilanjutkan mempresensi siswa   dan memberikan motivasi,

dorongan  kepada siswa untuk siap belajar.
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ii) Guru memberikan apersepsi yang berhubungan dengan

materi yang akan disampaikan agar mendapat respon dari

siswa.

b) Inti Pembelajaran

i) Guru mengingatkan materi yang sudah dijelaskan pada

pertemuan pertama.

ii) Guru mempersilahkan siswa untuk mencoba dan

mempraktekkan logika-logika dasar menggunakan program

simulator dan mencoba mengerjakan contoh contoh

permasalahan.

iii) Guru mempersilahkan setiap kelompok untuk mengajukan

masalah dan menyelesaikannya sendiri.

iv) Salah satu kelompok mempresentasikan hasil pengajuan

masalah yang telah dibuat beserta penyelesaiannya.

c) Penutup

i) Guru mereview materi yang baru saja disampaikan.

ii) Guru memberikan kesempatan kepada siswa untuk

menanyakan hal-hal yang masih kurang jelas.

iii) Guru memberikan tes akhir siklus I.

iv) Guru memberi salam penutup memimpin berdoa dan keluar

meninggalkan kelas.



45

c. Refleksi sikus I

Berdasarkan tindakan pada siklus I meliputi perencanaan

dan pelaksanaan tindakan serta hasil observasi dapat dilakukan hasil

refleksi. Peneliti dan kolaborator mendiskusikan hasil pelaksanaan

tindakan. Dan adapun permasalahan-permasalahan yang dihadapi

antara lain adalah:

1) Siswa merasa canggung untuk berdiskusi dan mengerjakan soal

dikarenakan belum begitu akrab dengan teman satu kelompoknya.

2) Siswa masih kesulitan dalam membuat soal dan menyelesaikan

soal yang dibuatnya dengan menggunakan kalimatnya sendiri.

3) Masih ada siswa yang tidak mau bertanya ketika mengalami

kesulitan dalam belajar.

4) Siswa belum berani maju ke depan untuk menyampaikan hasil

diskusinya dan menuliskan soal yang dibuat beserta

penyelesaianya, mereka harus ditunjuk terlebih dahulu, dan hanya

beberapa siswa saja yang mau.

Dari hasil refleksi dapat disimpukan bahwa pelaksanaan

pembelajaran pada siklus I masih terdapat banyak kekurangan

sehingga perlu dilaksanakan siklus lanjutan yaitu siklus II dengan

beberapa revisi yang didasarkan pada refleksi siklus I.
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2. Penelitian Tindakan Kelas Siklus II

a. Perencanaan

Pada tahap perencanaan silkus II, kegiatan peneliti secara

umum sama dengan kegiatan perencanaan siklus I. Namun terdapat

beberapa tambahan berdasar refleksi siklus I yaitu adalah:

1) Memberikan perhatian serta motivasi kepada siswa untuk tidak

takut mencoba dan bertanya ketika mengalami kesulitan.

2) Memberikan kesempatan yang sama kepada setiap siswa, baik

siswa yang aktif maupun tidak begitu aktif.

b. Pelaksanaan Tindakan dan Hasil Observasi

1) Pertemuan Pertama

Pertemuan pertama siklus II dilaksanakan pada hari senin, 13

Februari 2012. Pada pertemuan pertama ini difokuskan untuk

mempelajari mendownload program ke PLC menggunakan CX-

Programmer.

Siswa tetap dibagi dalam 8 kelompok seperti pada siklus I.

Setiap siswa dikondisikan untuk bekerja sama dengan  kelompok

untuk mengerjakan contoh-contoh soal dan mengajukan sebuah

masalah selama waktu yang telah ditentukan dan guru.

Selanjutnya pada kegiatan penutup, peneliti mengevaluasi

pelajaran dan memberikan kesempatan kepada siswa untuk
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menanyakan hal-hal yang belum dimengerti. Adapun pelaksanaan

pembelajaran mata diklat PLC pada siklus II sebagai berikut:

a) Kegiatan Awal

i) Guru masuk kelas, memberi salam kemudian  dilanjutkan

mempresensi siswa

ii) Guru memberikan motivasi, dorongan  kepada siswa untuk

siap belajar.

iii) Guru memberikan apersepsi yang berhubungan dengan materi

yang akan disampaikan agar mendapat respon dari siswa.

b) Inti Pembelajaran

i) Guru menjelaskan materi yang dipelajari.

ii) Guru mempersilahkan siswa untuk mencoba program yang

dibuatnya menggunakan CX-Programer.

iii) Guru mempersilahkan siswa untuk menyampaikan semua

permasalahan atau kendala yang dihadapi.

iv) Salah satu kelompok mempresentasikan penyelesaian kendala

yang dihadapinya.

c) Penutup

i) Guru mereview materi yang baru saja disampaikan.

ii) Guru memberikan kesempatan kepada siswa untuk

menanyakan hal-hal yang masih kurang jelas.

iii) Guru memberi salam penutup memimpin berdoa dan keluar

meninggalkan kelas.
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2) Pertemuan Kedua

Pertemuan kedua dilaksanakan pada hari selasa, tanggal

14 Februari 2012.

a) Kegiatan Awal

i) Guru masuk kelas, memberi salam, memimpin doa,

kemudian  dilanjutkan mempresensi siswa   dan

memberikan motivasi, dorongan  kepada siswa untuk siap

belajar.

ii) Guru memberikan apersepsi yang berhubungan dengan

materi yang akan disampaikan agar mendapat respon dari

siswa.

b) Inti Pembelajaran

i) Guru mengingatkan materi yang sudah dijelaskan pada

pertemuan sebelumnya.

ii) Guru menyampaikan materi tentang penggunaan timer dan

counter.

iii) Guru mempersilahkan siswa untuk mencoba dan

mempraktekkan contoh-contoh soal mengenai timer dan

counter.

iv) Guru mempersilahkan setiap kelompok untuk mengajukan

masalah dan menyelesaikannya sendiri

vi) Salah satu kelompok mempresentasikan hasil pengajuan

masalah yang telah dibuat beserta penyelesaiannya.
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c) Penutup

a) Guru mereview materi yang baru saja disampaikan.

b) Guru memberikan kesempatan kepada siswa untuk

menanyakan hal-hal yang masih kurang jelas.

c) Guru memberikan tes akhir siklus II

d) Guru memberi salam penutup memimpin berdoa dan keluar

meninggalkan kelas.

3) Refleksi Siklus II

Setelah tindakan yang dilakukan pada siklus II berakhir,

peneliti melakukan refleksi terhadap data yang telah diperoleh

selama pelaksanaan tindakan. Refleksi yang dilakukan ini sekaligus

akhir dari rangkaian tindakan yang telah dilakukan.

Berdasarkan pengamatan selama kegiatan pembelajaran

siklus II, terlihat bahwa kegiatan pembelajaran berjalan dengan

lancar dan lebih baik dari siklus sebelumnya. Kegiatan siswa sudah

mulai tampak terlihat dari munculnya keberanian siswa untuk

bertanya kepada guru maupun teman, menjawab pertanyaan, yang

diaukan guru, mengungkapkan pendapatnya dan menuliskan soal

yang dibuatnya tanpa harus ditunjuk.

Guru memberikan bimbingan dan perhatian yang lebih

merata kepada setiap siswa. Sehingga siswa tidak merasa takut
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ataupun malu untuk bertanya mengenai permasalahan yang belum

dipahami.

Pelaksanaan tindakan kelas siklus II ini juga tak lepas dari

beberapa permasalahan, permasalahannya adalah kemampuan siswa

yang tidak merata sehingga hasil yang dicapai tidak merata.

Rata-rata hasil tes siklus II adalah 71,60. Lebih baik dari

pada siklus I sebesar 69,63.

B. Deskripsi Hasil Penelitian

1. Hasil Tes Siklus I dan Tes Siklus II

Hasil tes pada siklus I dan siklus II digunakan untuk mengetahui

ada tidaknya peningkatan prestasi belajar siswa setelah mengikuti

pembelajaran dengan pendekatan problem posing. Adapun penjabaran

deskripsi statistik pada siklus I dan siklus II yang diperoleh dari hasil test

adalah sebagai berikut.
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a. Siklus I

Tabel 6 Hasil Tes Siklus I

No. Nama Siswa Hasil tes
1. Achmad Bagus Dewa P 96
2. Adi Irawan 56
3. Adib Rizal Fahmi 87
4. Aditya Dwi C 82
5. Alfian Rizky S 79
6 Arif Wahyudi 89
7. Bahtiar Nugroho 68
8. Damas Panji A 86
9. Dewi Aprilia 63

10. Dima Abdi Kurniawan 81
11. Dwiky Ardy C.P 68
12. Eko Budi S 71
13. Elva R.E 66
14. Fahmi N.S 45
15. Febri A 45
16. Ganjar T 37
17. Hendro 71
18. Ibnu Syambudi 66
19. Irfan E 54
20. Ismail F 56
21. Kasnuri Wahyudi 63
22. Kurniawan 76
23. Lilis R 63
24. Martha Adi N 83
25. Ndendik Hermawan 66
26. Panji Lelono 78
27. Pendi Hidayat 74
28. Pendri A 61
29. Rohmat Dwijayanto 86
30. Sidig Prianto 51
31. Sugeng Pratopo 74
32. Sugeng Riyanto 71
33. Tri Hayat Nurhidayat 86
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Deskripsi statistik siklus I

Modus (Mo) = 86

Median(Me) = 71

Mean(M) = 66,5

Standar Deviasi (SD) = 9,82

Tabel 7 Kategori Hasil Tes Siswa Siklus I

No Kategori Jumlah
Siswa

Persentase

1
Rendah (0 – 60) 7 21,21%

2
Sedang (61 – 70) 9 27,27%

3
Tinggi (71 – 80) 8 24,24%

4
Sangat Tinggi (80 – 100) 9 27,27%

Total
33 100%

Perhitungan persentase nilai siswa diperoleh dari :

Keterangan :

f = Frekuensi banyaknya siswa yang memperoleh nilai pada

masing-masing kategori

n = Jumlah siswa keseluruhan
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b. Siklus II

Tabel 8 Hasil Tes Siklus II

No. Nama Siswa Hasil tes
1. Achmad Bagus Dewa P 89
2. Adi Irawan 69
3. Adib Rizal Fahmi 84
4. Aditya Dwi C 72
5. Alfian Rizky S 74
6 Arif Wahyudi 81
7. Bahtiar Nugroho 67
8. Damas Panji A 87
9. Dewi Aprilia 66

10. Dima Abdi Kurniawan 81
11. Dwiky Ardy C.P 75
12. Eko Budi S 76
13. Elva R.E 87
14. Fahmi N.S 58
15. Febri A 48
16. Ganjar T 56
17. Hendro 74
18. Ibnu Syambudi 71
19. Irfan E 52
20. Ismail F 64
21. Kasnuri Wahyudi 69
22. Kurniawan 71
23. Lilis R 67
24. Martha Adi N 71
25. Ndendik Hermawan 81
26. Panji Lelono 79
27. Pendi Hidayat 63
28. Pendri A 75
29. Rohmat Dwijayanto 85
30. Sidig Prianto 51
31. Sugeng Pratopo 89
32. Sugeng Riyanto 80
33. Tri Hayat Nurhidayat 92
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Deskriptif statistik siklus II

Modus (Mo) = 81

Median(Me) = 74

Mean(M) = 70

Standar Deviasi (SD) = 7,33

Tabel 9 Kategori Hasil Tes Siswa Siklus II

No Kategori Jumlah Siswa Persentase

1
Rendah (0 – 60) 5 15,15%

2
Sedang (61 – 70) 7 21,21%

3
Tinggi (71 – 80) 11 33,33%

4
Sangat Tinggi (80 – 100) 10 30,30%

Total
33 100%

Perhitungan persentase nilai siswa diperoleh dari :

Keterangan :

f = Frekuensi banyaknya siswa yang memperoleh nilai pada

masing-masing kategori

n = Jumlah siswa keseluruhan
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Gambar 2 Grafik Kategori nilai Hasil Tes Siswa Siklus I dan Siklus II

2. Analisis Aktivitas Siswa

Analisis aktivitas siswa dalam pembelajaran PLC menggunakan

pendekatan problem posing dianalisis secara deskriptif persentase. Adapun

perhitungan persentasenya diperoleh melalui rumus di bawah ini :
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Tabel 10 Persentase Aktivitas Siswa

No. Aktivitas Siklus I Siklus II

1.
Listening 83,32% 90,9%

2.
Oral 21,21% 34,84%

3.
Writing 53,02% 36,36%

4.
Visual 75,75% 75,75%

5.
Emotion 40,90% 45,45%

6.
Drawing 22,72% 27,27%

7.
Mental 66,66% 66,66%

8.
Motor 34,84% 68,17%

Dari tabel diatas dapat hitungan perolehan nilai rata-rata  aktivitas

siswa pada siklus I sebesar 49,80% dan pada siklus II sebesar 55,67%

Gambar 3 Grafik Persentase aktivitas siswa
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C. Pembahasan

Berdasarkan deskripsi penelitian dan hasil penelitian yang diuraikan

sebelumnya, diketahui bahwa pelaksanaan pembelajaran matematika melalui

pendekatan problem posing telah mampu meningkatkan prestasai siswa kelas

XI EI di SMK Negreri 2 Wonosari  pada mata pelajaran PLC, hal ini sterlihat

berdasarkan data yang diperoleh melalui hasil tes siklus I dan tes siklus II.

Pembelajaran diawali dengan penyampaian tujuan pembelajaran dan

apersepsi. Apersepsi dilakukan oleh guru untuk mengaitkan materi

pembelajaran yang akan dipelajari dengan materi pembelajaran yang akan

dipelajari. Hal ini bertujuan untuk memotivasi siswa agar siswa dapat

berperan aktif dalam pembelajaran. Setelah menyampaikan tujuan dan

apersepsi, guru mulai menjelaskan materi pembelajaran.

Pembelajaran dengan pendekatan problem posing merupakan

pembelajaran yang memberikan kesempatan bagi siswa untuk membuat soal

beserta penyelesaiannya sendiri setelah siswa selesai mengerjakan contoh-

contoh soal yang diberikan. Contoh-contoh soal diberikan kepada setiap

kelompok yang terdiri dari 4 atau 5 siswa. Pengelompokan tersebut bertujuan

agar siswa dapat lebih banyak berbagi informasi serta pengalaman dalam

memecahkan masalah dengan temannya. Dengan diskusi kelompok ini,

memungkinkan siswa untuk berbagi informasi, saling membantu,

meningkatkan motivasi serta membangun sikap yang diperlukan seperti mau

menerima kritik dan menyampaikan kritik.
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Contoh-contoh soal yang diberikan kepada siswa menuntut siswa

untuk memberikan alasan pada setiap langkahnya. Sehingga dapat melatih

siswa dalam menganalisa permasalahan. Setelah selesai mengerjakan contoh-

contoh soal siswa bersama dengan guru membahas soal-soal yang telah

dikerjakan.

Setelah selesai membahas contoh-contoh soal, setiap kelompok

diminta untuk membuat soal beserta penyelesaianya berdasarkan materi yang

telah dipelajari. Dalam pembelajaran problem posing ini guru berperan

sebagai fasilitator dan pembimbing dalam kegiatan pembelajaran sehingga

pembelajaran dapat berjalan dengan baik. Guru memantau jalanya diskusi

dan membimbing siswa yang mengalami kesulitan, sehingga hubungan guru

dan murid menjadi lebih dekat. Selain itu, guru juga memberikan motivasi

kepada siswa untuk aktif selama pembelajaran berlangsung.

Pada siklus I, siswa masih merasa sungkan untuk bertanya apabila

belum memahami materi pelajaran dan enggan menyajikan soal beserta

penyelesaiannya di papan tulis. Siswa mau menyampaikan hasil diskusi dan

soal yang dibuatnya apabila ditunjuk oleh guru.

Pada siklus II siswa sudah dapat bekerja sama dengan anggota

kelompoknya. Siswa berani bertanya dengan guru apabila belum memahami

materi yang diajarkan. Siswa bersedia menuliskan soal beserta

penyelesaianya tanpa harus ditunjuk oleh guru.

Pada akhir setiap silkus dilaksanakan tes untuk mengetahui

pemahaman siswa tentang materi yang telah dipelajari. Prestasi dan aktivitas
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siswa kelas XI EI SMKN 2 Wonosari dikatakan mengalami peningkatan

setelah mengikuti pebelajaran PLC menggunakan pendekatan problem

posing. Peningkatan tersebut dapat diuraikan sebagai berikut:

1. Peningkatan rata-rata nilai tes dari siklus I ke siklus II sebesar 5,26%

yaitu dari 66,5 menjadi 70.

2. Berkurangnya jumlah kategori hasil tes siswa. Kategori rendah, dari 7

siswa menjadi 5 siswa atau dari 21,21% menjadi 15,15%.

3. Berkurangnya jumlah kategori hasil tes siswa. Kategori sedang dari 9

siswa menjadi 7 siswa atau 27,27% menjadi 21,21%

4. Meningkatnya jumlah kategori hasil tes siswa. Kategori tinggi dari 8

siswa menjadi 11 siswa atau 24,24% menjadi 33,33%

5. Meningkatnya jumlah kategori hasil tes siswa. Kategori baik sekali dari 9

siswa menjadi 10 siswa atau 27,27% menjadi 30,30%

6. Meningkatnya perolehan nilai rata-rata aktivitas siswa sebesar 50,37%

menjadi 55,10%

Dari data di atas tampak bahwa hasil tes siswa mengalami

peningkatan. Dimana kategori kurang dan kategori cukup mengalami

penurunan. Sedangkan kategori baik dan baik sekali mengalami peningkatan.

Berdasarkan lembar observasi aktifitas siswa, diperoleh informasi

bahwa adanya peningkatan dalam aktivitas oral atau bertanya. Hal ini

menandakan adanya keberanian siswa untuk bertanya kepada guru jika ada

materi yang belum dimengerti. Juga menandakan adanya keberanian dan

keinginan siswa untuk memberikan tanggapan ataupun mengungkapkan
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pendapatnya terhadap suatu masalah. Dengan adanya keinginan tersebut

siswa cenderung lebih tertarik dan memberikan respon yang positif terhadap

mata pelajaran yang diikutinya. Dengan menggunakan pendekatan problem

posing ini siswa diajak untuk tidak hanya menghafalkan gambar-gambar

rangkaian atau bentuk ladder diagram saja. Tetapi siswa diajak untuk

memahami lebih lanjut tentang membentuk pengetauan mereka untuk

memecahkan suatu masalah.

Berdasarkan data-data yang diperoleh dari hasil observasi dan hasil

tes, peneliti menyimpulkan bahwa prestasi belajar siswa dalam pembelajaran

PLC melalui pendekatan problem posing pada siswa XI EI SMK Negeri 2

Wonosari mengalami peningkatan.

D. Ketebatasan Penelitian

Penelitian yang telah dilakukan dikelas XI EI SMK Negeri 2

Wonosari mengaami keterbatasan, antara lain :

1. Waktu pelajaran yang terbatas sehingga dalam pembahasan jawaban yang

dibuat siswa dalam kelas tidak semua terlaksana.

2. Proses pengamatan dalam penelitian hanya dilakukan oleh peneliti dibantu

seorang observer lain yang sekaligus membantu jalanya diskusi. Hal ini

menyebabkan kegiatan pengamatan dan pencatatan kurang maksimal.

3. Terdapat beberapa komputer yang rusak dan tidak dapat digunakan.

Sehingga media untuk praktek sangat terbatas.
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BAB V

KESIMPULAN DAN SARAN

A. Kesimpulan

Berdasarkan hasil penelitian dan pembahasan yang telah diuraikan

dapat disimpulkan :

1. Dengan menggunakan pendekatan problem posing aktivitas belajar siswa

SMK N 2 Wonosari terhadap pembelajaran PLC mengalami peningkatan.

Dengan peningkatan sebesar 11,78% atau dari 49,80% pada siklus I

menjadi 55,67% pada siklus II.

2. Prestasi siswa SMK N 2 Wonosari kelas XI EI terhadap pembelajaran

PLC melalui pendekatan problem posing meningkat. Dengan rincian, pada

siklus I nilai rata-rata siswa sebesar 66,5 dan pada siklus II nilai rata-rata

yang diperoleh sebesar 70 Dari kategori hasil tes siswa juga mengalami

peningkatan. Dari kategori sangat tinggi dari 27,27% menjadi 30,30%,

kategori tinggi dari 24,24% menjadi 33,33%. Sedang pada kategori sedang

turun dari 27,27% menjadi 21,21% dan pada kategori rendah juga

mengalami penurunan dari 21,21% menjadi 15,15%.



62

B. Saran

Berdasarkan hasil penelitian dan kesimpulan di atas, maka peneliti

mempunyai beberapa saran yang perlu dipertimbangkan yaitu:

1. Pembelajaran menggunakan pendekatan problem posing yang telah

dillaksanakan dengan menggunakan tahapan-tahapannya dapat

meningkatkan aktifitas siswa dalam belajar dan prestasi belajar, maka guru

PLC dapat mencobakan model pendekatan tersebut.

2. Sebelum melaksanakan pembelajaran dengan menggunakan pendekatan

problem posing, perangkat pembelajaran seperti RPP, contoh-contoh soal,

dan soal tes harus disiapkan terlebih dahulu dengan baik.

3. Pembelajaran melalui pendekatan problem posing dapat diterapkan

dilaksanakan secara berkelanjutan untuk mengatasi kesulitan belajar siswa

secara individual.
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RENCANA PELAKSANAAN PEMBELAJARAN

(RPP)

Program Keahlian : Teknik Pemanfaatan Energi
Mata Pelajaran : Kompetensi Kejuruan Teknik Pemanfaatan Energi Listrik
Satuan Pendidikan : SMK Negri 2 Wonosari
Kelas/Smester : XI / II
Pertemuan ke : siklus I pertemuan I
Alokasi Waktu : 2 x 45 menit
Standar Kompetensi : Mengoperasikan mesin produksi menggunakan kendali PLC
Kode Kompetensi : PTL.OPS.006(2).A
Kompetensi Dasar : Mempersiapkan operasi mesin produksi dengan kendali PLC

TUJUAN PEMBELAJARAN

Setelah pembelajaran siswa dapat :

a. Siswa dapat merencanakan program kendali PLC.

b. Siswa dapat menjalankan program kendali PLC

c. Siswa dapat menyampaikan permasalahan dan menyelesaikannya

I. MATERI AJAR:

A. Pengenalan PLC

B. Logika Dasar

II. METODE PEMBELAJARAN

A. Ceramah

B. Diskusi

C. Praktik

III. LANGKAH-LANGKAH PEMBELAJARAN:

No. Kegiatan Waktu

1. Kegiatan Awal

• Berdo’a
• Presensi

5 menit
5 menit

2. Kegiatan Inti
• Pengenalan PLC dan Logika Dasar PLC

• Mengerjakan contoh-contoh soal logika dasar

• Membuat soal sendiri dan menyelesaikannya

30 menit

20 menit

20 menit



66

3. Kegiatan Akhir
• Evaluasi
• Berdo’a dan salam penutup

5 menit
5 menit

IV. SUMBER BELAJAR

 Buku PLC Teknik Perancangan Sistem Kontrol (karangan Iwan Stiawan)

V. PENILAIAN

 Keaktivan

Yogyakarta, 2 Februari 2012

Peneliti

Hizkiawan Krisdianto
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RENCANA PELAKSANAAN PEMBELAJARAN

(RPP)

Program Keahlian : Teknik Pemanfaatan Energi
Mata Pelajaran : Kompetensi Kejuruan Teknik Pemanfaatan Energi Listrik
Satuan Pendidikan : SMK Negri 2 Wonosari
Kelas/Smester : XI / II
Pertemuan ke : siklus I pertemuan II
Alokasi Waktu : 4 x 45 menit
Standar Kompetensi : Mengoperasikan mesin produksi menggunakan kendali PLC
Kode Kompetensi : PTL.OPS.006(2).A
Kompetensi Dasar : Mempersiapkan operasi mesin produksi dengan kendali PLC

TUJUAN PEMBELAJARAN

Setelah pembelajaran siswa dapat :

a. Siswa dapat merencanakan program kendali PLC.

b. Siswa dapat menjalankan program kendali PLC

c. Siswa dapat menyampaikan permasalahan dan menyelesaikannya

I. MATERI AJAR:

A. Logika Dasar PLC

B. Aplikasi Logika Dasar pada mesin-mesin Produksi

II. METODE PEMBELAJARAN

A. Ceramah

B. Diskusi Tim

C. Praktik

III. LANGKAH-LANGKAH PEMBELAJARAN:

No. Kegiatan Waktu

1. Kegiatan Awal

• Berdo’a
• Presensi

5 menit
5 menit

2. Kegiatan Inti
• Menyampaikan penggunaan Logika Dasar dalam

kehidupan sehari – hari dan mesin produksi

• Praktik Membuat Program Logika Dasar

• Mencoba dan mengulas contoh – contoh soal

10 menit

30 menit

35 menit
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• Membuat soal sendiri dan menyelesaikannya

• Mengerjakan soal test Siklus I
30 menit

60 menit
3. Kegiatan Akhir

• Evaluasi
• Berdo’a dan salam penutup

10 menit
5 menit

IV. SUMBER BELAJAR

 Buku PLC Teknik Perancangan Sistem Kontrol (karangan Iwan Stiawan)

V. PENILAIAN

 Keaktivan

 Tes

Yogyakarta, 2 Februari 2012

Guru Mata Pelajaran

Hizkiawan Krisdianto
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RENCANA PELAKSANAAN PEMBELAJARAN

(RPP)

Program Keahlian : Teknik Pemanfaatan Energi
Mata Pelajaran : Kompetensi Kejuruan Teknik Pemanfaatan Energi Listrik
Satuan Pendidikan : SMK Negri 2 Wonosari
Kelas/Smester : XI / II
Pertemuan ke : siklus II pertemuan I
Alokasi Waktu : 2 x 45 menit
Standar Kompetensi : Mengoperasikan mesin produksi menggunakan kendali PLC
Kode Kompetensi : PTL.OPS.006(2).A
Kompetensi Dasar : Mempersiapkan operasi mesin produksi dengan kendali PLC

TUJUAN PEMBELAJARAN

Setelah pembelajaran siswa dapat :

a. Siswa dapat merencanakan program kendali PLC.

b. Siswa dapat menjalankan program kendali PLC

c. Siswa dapat menyampaikan permasalahan dan menyelesaikannya

I. MATERI AJAR:

A. Pemrogaman PLC

B. Timer Counter

II. METODE PEMBELAJARAN

A. Ceramah

B. Diskusi

C. Praktik

III. LANGKAH-LANGKAH PEMBELAJARAN:

No. Kegiatan Waktu

1. Kegiatan Awal

• Berdo’a
• Presensi

5 menit
5 menit

2. Kegiatan Inti

• Mengulas materi sebelumnya

• Pemrograman PLC

• Memprogram PLC

10 menit

15 menit

40 menit
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• Preview materi Timer Counter 5 menit

3. Kegiatan Akhir
• Evaluasi
• Berdo’a dan salam penutup

5 menit
5 menit

IV. SUMBER BELAJAR

 Buku PLC Teknik Perancangan Sistem Kontrol (karangan Iwan Stiawan)

V. PENILAIAN

 Keaktivan

Yogyakarta, 2 Februari 2012

Guru Mata Pelajaran

Hizkiawan Krisdianto
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RENCANA PELAKSANAAN PEMBELAJARAN

(RPP)

Program Keahlian : Teknik Pemanfaatan Energi
Mata Pelajaran : Kompetensi Kejuruan Teknik Pemanfaatan Energi Listrik
Satuan Pendidikan : SMK Negri 2 Wonosari
Kelas/Smester : XI / II
Pertemuan ke : siklus I pertemuan II
Alokasi Waktu : 4 x 45 menit
Standar Kompetensi : Mengoperasikan mesin produksi menggunakan kendali PLC
Kode Kompetensi : PTL.OPS.006(2).A
Kompetensi Dasar : Mempersiapkan operasi mesin produksi dengan kendali PLC

TUJUAN PEMBELAJARAN

Setelah pembelajaran siswa dapat :

a. Siswa dapat merencanakan program kendali PLC.

b. Siswa dapat menjalankan program kendali PLC

c. Siswa dapat menyampaikan permasalahan dan menyelesaikannya

I. MATERI AJAR:

A. Latihan penggunan  timer, counter pada program PLC

II. METODE PEMBELAJARAN

A. Ceramah

B. Diskusi Tim

C. Praktik

III. LANGKAH-LANGKAH PEMBELAJARAN:

No. Kegiatan Waktu

1. Kegiatan Awal
• Berdo’a
• Presensi

5 menit
5 menit

2. Kegiatan Inti
• Mengulas materi sebelumnya

• Praktik Membuat Program timer counter

• Mencoba dan mengulas contoh – contoh soal

• Membuat soal sendiri dan menyelesaikannya

10 menit

30 menit

35 menit

30 menit
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• Mengerjakan soal test Siklus I 60 menit

3. Kegiatan Akhir
• Evaluasi
• Berdo’a dan salam penutup

10 menit
5 menit

IV. SUMBER BELAJAR

 Buku PLC Teknik Perancangan Sistem Kontrol (karangan Iwan Stiawan)

V. PENILAIAN

 Keaktivan

 Tes

Yogyakarta, 2 Februari 2012

Guru Mata Pelajaran

Hizkiawan Krisdianto



Lampiran 2
2.1 Contoh soal-soal 12.2 Contoh soal-soal 2
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Soal praktik Logika

Buatlah rangkaian ladder diagram dan program PLC, dengan ketentuan kerja :

1. Ada 2 saklar  dan  3 lampu, ke 3 lampu dapat menyala jika saklar 1 dan saklar

2 ditekan.

2. Ada 2 saklar dan 3Lampu, ketiga lampu akan menyala jika salah satu saklar di

tekan.

3. Ada 2 motor Dc, ke 2 motor hidup jika saklar 1 ditekan dan akan terus hidup

walaupun saklar di lepas.

4. Ada 3 Lampu dan 2 saklar, lampu 1 dan 2 menyala jika saklar 1 di tekan dan

lampu 3 akan menyala jika saklar 2 di tekan dan pada waktu bersamaan

lampu 1dan 2 mati.
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Soal praktik Timer – Counter

Buatlah rangkaian ladder diagram dan program PLC, dengan ketentuan kerja :

1. ada 2 buah motor, motor 1 akan berputar jika  tombol start di tekan selang 4

detik motor 2 hidup selang 5 detik semua motor mati.

2. ada 3 buah motor, motor 1 akan berputar jika  tombol start di tekan,  selang 4

detik motor 2 hidup selang 5 detik 1 dan 2 motor mati dan pada saat

bersamaan motor 3 hidup, Semua motor akan mati jika tombol off di tekan.

3. Ada 1 lampu, Lampu 1 menyala setelah saklar 1 ditekan 3 kali.

4. Ada 2 lampu, lampu 1 menyala jika saklar  1 ditekan 2kali dan lampu 2

menyala jika saklar 2 di tekan 4 kali. saat lampu 2 menyala lampu 1 mati.



Lampiran 3
3.1 Kisi-kisi tes siklus I3.2 Soal tes siklus I3.3 Kunci Jawaban tes siklus I3.4 Kisi-kisi tes siklus II3.5 Soal tes siklus II3.6 Kunci jawaban tes siklus II
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KISI – KISI TES SIKLUS I

No. Kompetensi Dasar
Indikator Pencapaian

Kompetensi Dasar
Jumlah No. Soal

1.

Mempersiapkan

operasi mesin

produksi dengan

kendali PLC

Ruang Lingkup PLC

a. Pengertian

b. Keuntungan dan kelebihan PLC

c. Bagian-bagian PLC

d. Daerah penerapan PLC

4
No.

1, 2, 3, 4,

Prinsip kerja PLC:

a. Bahasa pemrograman

b. Logika Dasar AND,OR,

NOT,NAND,XOR

5
No.

5, 6, 7, 8, 9,
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SOAL TEST  SIKLUS I

Nama : _____________________

Kelas : _____________________

No : _____________________

1. Apakah sesungguhnya PLC itu ?

2. Sebutkan masing-masing tiga contoh dari :

a. Alat input

b. Alat output

c. Alat penunjang

3. Sebutkan lima keunggulan PLC dibandingkan dengan sistem kendali elektromagnet !

4. Sebutkan lima daerah penerapan PLC !

5. Apakah yang dimaksud dengan program ?

6. Sebutkan dua macam bentuk program kendali PLC !

7. Gambarkan simbol dan tabel kebenaran suatu sistem yang memiliki keluaran berlawanan dengan

masukannya !

8. Gambarkan ladder diagram dari sistem berikut, dua buah lampu menyala ketika kedua saklarnya

ditekan secara bersamaan, dan tidak menyala ketika salah satu saklarnya saja yang ditekan !

9. Buatlah soal cerita dalam kehidupan sehari-hari mengenai penerapan logika dasar kemudian

selesaikanlah soal yang kalian tersebut !
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Jawaban tes siklus I

No. Jawaban Skor

1. PLC adalah alat pengendali suatu mesin atau suatu proses yang dapat diprogram 5

2. (periksa tiga jawaban diantara jawaban berikut)

a. Alat input

- tombol, sensor, saklar, rotary encoder, saklar proximity

b. Alat output

- lampu, kontaktor/relai, buzzer, motor

c. Alat penunjang

- konsol pemrograman, komputer, software, printer

5

5

5

3. (periksa lima jawaban diantara jawaban berikut)

a. Pengawatan sistem kendali menjadi berkurang 80%dibanding sistem relai

b. Konsumsi daya berkurang

c. Melacak kesalahan sistem lebih mudah dibanding sistem relai

d. Mudah dalam memodifikasi urutan kendali

e. Ruang kerja sistem PLC lwbih kecil

f. Harganya lebih murah

g. Program dapat didokumentasikan secara cepat dan mudah

15

4. (periksa lima jawaban diantara jawaban berikut)

a. Pengendali lampu lalu lintas

b. Pengendali robot

c. Pengendali mesin

d. Pengendali lift

e. Pengendali conveyor

15

5. Program adalah sederetan instruksi yang disusun secara berurutan 5

6. a. ladder diagram

b. kode mneumonik

5

5

7. Gambar logika NOT

Tabel logika NOT

Input output
A Y
0 1
1 0

5

5
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8.

5

9. Membuat soal yang berkaitan dengan kehidupan sehari-hari.

- Siswa membuat soal dengan menggunakan bahasa yang mudah dipahami

- Penyelesaian benar

10

10
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KISI – KISI TES SIKLUS II

No. Kompetensi Dasar
Indikator Pencapaian

Kompetensi Dasar
Jumlah No. Soal

1.

Mempersiapkan

operasi mesin

produksi dengan

kendali PLC

Teknik pemrograman PLC:

a. Pemrograman PLC

b. Membuat kendali program PLC

c. Mengecek kebenaran Program

d. Memasukkan program ke dalam

PLC

9

No.

1, 2, 3, 4, 5,

6, 7, 8, 9
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SOAL TEST  SIKLUS II

Nama : _____________________

Kelas : _____________________

No : _____________________

1. Sebutkan tiga jenis alat yang digunakan untuk memprogram PLC !

2. Sebutkan perintah standar dalam CX Programmer untuk :

b. Menggambar kontak NO

c. Menggambar kontak NC

d. Menggambar garis horizontal

e. Menggambar kumparan

f. Menggambar instruksi END

3. Jelakan fungsi dari insrtuksi dibawah ini :

a. TIMER

b. COUNTER

4. Apakah syarat-syarat untuk dapat mentransfer program darikomputer ke dalam PLC ?

5. Apakah yang dimaksud dengan down-load, dan indikator apa yang menunjukkan bahwa down-

load telah berhasil?

6. Jelaskan apa yang terjadi jika tombol 0.01 dan tombol 0.00 ditekan !

7. Buatlah ladder diagram dari sistem berikut :

Jika tombol start ditekan sebanyak 5 kali, motor akan berputar. Dan akan berhenti jika tombol stop

ditekan.

8. Buatlah ladder diagram dari pengendali motor yang beputar bergantian jika tombol start ditekan

motor 1 berputar selama 5 detik dan berhenti kemudian motor 2 berputar selama 5 detik dan

berhenti.

9. Buatlah soal cerita dalam kehidupan sehari-hari mengenai penggunaan Timer atau Counter,

kemudian selesaikanlah soal yang kalian buat itu !
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Jawaban tes siklus II

No. Jawaban Skor

1. Alat yang digunakan untuk memprogram PLC

a. Konsol pemrograman

b. Komputer

c. Programmable Terminal

10

2. Perintah standar dalam CX Programmer untuk :

a. Menggambar kontak NO adalah insert > Contact > Normally Open

b. Menggambar kontak NC adalah insert > Contact > Normally Closed

c. Menggambar garis horizontal adalah Insert > Horizontal

d. Menggambar kumparan adalah Insert > Coil

e. Menggambar instruksi END adalah Insert > Instruktion > ketik END

10

3. a. Timer adalah instruksi dalam PLC yang digunakan untuk mencacah waktu yang

telah ditentukan.

b. Counter adalah instruksi dalam PLC yang digunakan untuk mencacah sinyal dari

luar PLC

5

5

4. Syarat program dapat didownload ke PLC adalah

- Saluran komunikasi data tersambung

- PLC dihubungkan ke catu daya

5

5

5. - Download adalah Mentransfer program dari komputer ke PLC

- Indikator saat program telah berhasil didownload adalah pada layar komputer muncul

pesan ‘Download successfull’

5

5

6. - Jika tombol 0.01 ditekan maka akan mengaktifkan coil 10.00 dan setelah sekian detik

kontaktor TIM 001 akan membuka dan memutus aliran menuju coil 10.00 sehingga

coil 10.00 mati.

- Jika tombol 0.00 ditekan maka arus yang menuju ke tombol 0.01 hingga 10.00

terputus, sehingga coil 10.00 tidak dapat hidup.

5

5
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7.

10

8.

10

9. Membuat soal yang berkaitan dengan kehidupan sehari-hari.

- Siswa membuat soal dengan menggunakan bahasa yang mudah dipahami

- Penyelesaian benar

10

10



Lampiran 4
4.1 Kisi-kisi Lembar observasi keterlaksanaanPembelajaran4.2 Lembar observasi keterlaksanaanPembelajaran4.3 Kisi-Kisi Lembar observasi aktivitas Siswa4.4 Lembar Observasi aktivitas Siswa
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Kisi-kisi lembar observasi keterlaksanaan pembelajaran problem posing

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

Membuka kegiatan pembelajaran.

Menyampaikan tujuan pembelajaran.

Memberikan materi pelajaran.

Memberikan contoh soal (merumuskan soal).

Memberikan kesempatan kepasa siswa untuk bertanya hal-hal yang

belum jelas.

Memberikan kesempatan kepada siswa untuk merumuskan soal dari

suatu situasi yang diberikan, serta mendiskusikan/mempresentasikan.

Mempersilahkan siswa menyelesaikan soal yang telah dirumuskanya.

Sebagai latihan, memberikan situasi tugas yang lain dan siswa diberikan

kesempatan untuk merumuskan soal sebanyak mungkin, serta

mendiskusikan dengan temanya.

Mempersilahkan siswa untuk saling menukar hasil rumusan soalnya dan

menyelesaikan soal temannya.

Mengarahkan siswa untuk membuat kesimpulan.

Membuat rangkuman berdasar kesimpulan yang dibuat siswa.

Menutup kegiatan belajar.
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LEMBAR OBSERVASI PELAKSANAAN PEMBELAJARAN
PLC DENGAN PENDEKATAN PROBLEM POSING

Nama Sekolah : Materi Pokok :
Hari/Tanggal : Siklus/Pertemuan ke :
Kelas/Jam :

Berilah tanda cek (√) pada salah satu kolom “Ya” atau “Tidak” yang tersedia dan
deskripsikan hasil pengamatan sesuai dengan apa yang telah anda amati selama proses
pembelajaran berlangsung.

No. Indikator/Aspek yang diamati Ya Tidak
Deskripsi Hasil

pengamatan
I. Kegiatan Awal

1. Guru mengawali pelajaran dengan berdoa.
2. Guru mengecek kesiapan siswa.
3. Guru menanyakan PR atau kesulitan siswa

dalam belajar.
4. Guru menyampaikan topik yang akan

dibahas.
5. Guru memotivasi siswa untuk

berpartisipasi aktif dalam pembelajaran.
6. Guru mengaitkan materi yang akan

dipelajari dengan kehidupan sehari hari.
7. Guru mengingatkan kembali materi yang

telah dipelajari sebelumnya.

II. Kegiatan Inti
1. Guru menyajikan materi pembelajaran.
2. Guru memberikan beberapa contoh soal

serta langkah-langkah penyelesaiannya.
3. Guru memberikan kesempatan pada siswa

untuk bertanya bila ada materi yang belum
dimengerti.

4. Siswa mengerjakan contoh-contoh soal
yang diberikan oleh guru.

5. Siswa bersama guru membahas contoh-
contoh soal yang telah diberikan.

6. Guru menyajikan soal yang berhubungan
dengan materi yang dipelajari.
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7. Siswa mengerjakan soal tersebut,
kemudian siswa membuat soal sendiri dan
mengerjakan sendiri berdasarkan stimulus
yang diberikan guru tersebut.

8. Guru memantau siswa dalam membuat
dan mengerjakan soal.

9. Setelah selesai salah satu siswa
mempresentasikan dan menyelesaikan soal
yang dibuatnya.

10.Siswa yang lain mengoreksi soal yang
telah ditulis di papan tulis dan menanggapi
soal dan penyelesaian yang telah dibuat
temannya tersebut.

III. Penutup
1. Siswa bersama guru menyimpulkan materi

yang telah dipelajari.
2. Guru memberikan PR kepada siswa
3. Guru meminta siswa untuk mempelajari

materi berikutnya.
4. Guru menutup pelajaran

Observer

( )
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KISI – KISI LEMBAR OBSERVASI AKTIVITAS SISWA

No. Aspek yang diamati Indikator

1. Listening Activities • Siswa mendengarkan penjelasan guru.

2. Oral Activities
• Siswa bertanya kepada guru / teman.

• Siswa menjawab pertanyaan dari guru.

3. Writing Activities

• Siswa mengerjakan contoh soal

• Siswa membuat soal dan  menyelesaikan soalnya

sendiri.

4. Visual Activities

• Siswa mepresentasikan soal dan penyelesaian yang

dibuatnya.

• Siswa memperhatikan hasil presentasi temannya.

5. Emotional Activities • Siswa bersemangat dalam belajar.

6. Drawing Activities • Siswa menggambar ladder diagram.

7. Mental Activities

• Siswa membuat soal dan menyelesaikannya sendiri

• Siswa membuat kesimpulan dari materi yang

dipelajarinya.

8. Motor Activties • Siswa melakukan percobaan dengan PLC
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LEMBAR OBSERVASI PELAKSANAAN PEMBELAJARAN
PLC DENGAN PENDEKATAN PROBLEM POSING

Nama Sekolah : SMK N 2 Wonosari Materi Pokok : Pengenalan PLC
Hari/Tanggal : Senin, 5 Februari 2012 Siklus/Pertemuan ke : I / I
Kelas/Jam : XI EI / 12.45 – 14.15

Berilah tanda cek (√) pada salah satu kolom “Ya” atau “Tidak” yang tersedia dan
deskripsikan hasil pengamatan sesuai dengan apa yang telah anda amati selama proses
pembelajaran berlangsung.

No. Indikator/Aspek yang diamati Ya Tidak
Deskripsi Hasil

pengamatan
I. Kegiatan Awal

1. Guru mengawali pelajaran dengan berdoa. √ Berdoa pada jam I
2. Guru mengecek kesiapan siswa. √
3. Guru menanyakan PR atau kesulitan siswa

dalam belajar.
√

4. Guru menyampaikan topik yang akan
dibahas.

√

5. Guru memotivasi siswa untuk
berpartisipasi aktif dalam pembelajaran.

√

6. Guru mengaitkan materi yang akan
dipelajari dengan kehidupan sehari hari.

√

7. Guru mengingatkan kembali materi yang
telah dipelajari sebelumnya.

√

II. Kegiatan Inti
1. Guru menyajikan materi pembelajaran. √ Pengenalan Plc &

zelio
2. Guru memberikan beberapa contoh soal

serta langkah-langkah penyelesaiannya.
√ Aplikasi sederhana

menggunakan simulasi
zelio

3. Guru memberikan kesempatan pada siswa
untuk bertanya bila ada materi yang belum
dimengerti.

√

4. Siswa mengerjakan contoh-contoh soal
yang diberikan oleh guru.

√

5. Siswa bersama guru membahas contoh-
contoh soal yang telah diberikan.

√
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6. Guru menyajikan soal yang berhubungan
dengan materi yang dipelajari.

√

7. Siswa mengerjakan soal tersebut,
kemudian siswa membuat soal sendiri dan
mengerjakan sendiri berdasarkan stimulus
yang diberikan guru tersebut.

√

8. Guru memantau siswa dalam membuat
dan mengerjakan soal.

√ Soal mandiri
dikerjakan secara

berkelompok
9. Setelah selesai salah satu siswa

mempresentasikan dan menyelesaikan soal
yang dibuatnya.

√

10.Siswa yang lain mengoreksi soal yang
telah ditulis di papan tulis dan menanggapi
soal dan penyelesaian yang telah dibuat
temannya tersebut.

√

III. Penutup
1. Siswa bersama guru menyimpulkan materi

yang telah dipelajari.
√

2. Guru memberikan PR kepada siswa √
3. Guru meminta siswa untuk mempelajari

materi berikutnya.
√

4. Guru menutup pelajaran √ Menutup dengan doa
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LEMBAR OBSERVASI PELAKSANAAN PEMBELAJARAN
PLC DENGAN PENDEKATAN PROBLEM POSING

Nama Sekolah : SMK N 2 Wonosari Materi Pokok : Logika Dasar
Hari/Tanggal : Selasa, 6 Februari 2012 Siklus/Pertemuan ke : I / II
Kelas/Jam : XI EI / 07.00 – 10.15

Berilah tanda cek (√) pada salah satu kolom “Ya” atau “Tidak” yang tersedia dan
deskripsikan hasil pengamatan sesuai dengan apa yang telah anda amati selama proses
pembelajaran berlangsung.

No. Indikator/Aspek yang diamati Ya Tidak
Deskripsi Hasil

pengamatan
I. Kegiatan Awal

1. Guru mengawali pelajaran dengan berdoa. √

2. Guru mengecek kesiapan siswa. √

3. Guru menanyakan PR atau kesulitan siswa
dalam belajar.

√

4. Guru menyampaikan topik yang akan
dibahas.

√

5. Guru memotivasi siswa untuk
berpartisipasi aktif dalam pembelajaran.

√

6. Guru mengaitkan materi yang akan
dipelajari dengan kehidupan sehari hari.

√

7. Guru mengingatkan kembali materi yang
telah dipelajari sebelumnya.

√

II. Kegiatan Inti
1. Guru menyajikan materi pembelajaran. √ Pengenalan Logika

dasar
2. Guru memberikan beberapa contoh soal

serta langkah-langkah penyelesaiannya.
√

3. Guru memberikan kesempatan pada siswa
untuk bertanya bila ada materi yang belum
dimengerti.

√

4. Siswa mengerjakan contoh-contoh soal
yang diberikan oleh guru.

√

5. Siswa bersama guru membahas contoh-
contoh soal yang telah diberikan.

√

6. Guru menyajikan soal yang berhubungan √
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dengan materi yang dipelajari.
7. Siswa mengerjakan soal tersebut,

kemudian siswa membuat soal sendiri dan
mengerjakan sendiri berdasarkan stimulus
yang diberikan guru tersebut.

√

8. Guru memantau siswa dalam membuat
dan mengerjakan soal.

√ Soal dikerjakan secara
berkelompok

9. Setelah selesai salah satu siswa
mempresentasikan dan menyelesaikan soal
yang dibuatnya.

√

10.Siswa yang lain mengoreksi soal yang
telah ditulis di papan tulis dan menanggapi
soal dan penyelesaian yang telah dibuat
temannya tersebut.

√

III. Penutup
1. Siswa bersama guru menyimpulkan materi

yang telah dipelajari.
√

2. Guru memberikan PR kepada siswa √
3. Guru meminta siswa untuk mempelajari

materi berikutnya.
√

4. Guru menutup pelajaran √
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LEMBAR OBSERVASI PELAKSANAAN PEMBELAJARAN
PLC DENGAN PENDEKATAN PROBLEM POSING

Nama Sekolah : SMK N 2 Wonosari Materi Pokok : Memprogram
Hari/Tanggal : Senin, 13 Februari 2012 PLC
Kelas/Jam : XI EI / 12.45 – 14.15 Siklus/Pertemuan ke : II / I

Berilah tanda cek (√) pada salah satu kolom “Ya” atau “Tidak” yang tersedia dan
deskripsikan hasil pengamatan sesuai dengan apa yang telah anda amati selama proses
pembelajaran berlangsung.

No. Indikator/Aspek yang diamati Ya Tidak
Deskripsi Hasil

pengamatan
I. Kegiatan Awal

1. Guru mengawali pelajaran dengan berdoa. √ Berdoa pada jam I
2. Guru mengecek kesiapan siswa. √
3. Guru menanyakan PR atau kesulitan siswa

dalam belajar.
√ Tidak ada PR

4. Guru menyampaikan topik yang akan
dibahas.

√

5. Guru memotivasi siswa untuk
berpartisipasi aktif dalam pembelajaran.

√

6. Guru mengaitkan materi yang akan
dipelajari dengan kehidupan sehari hari.

√

7. Guru mengingatkan kembali materi yang
telah dipelajari sebelumnya.

√

II. Kegiatan Inti
1. Guru menyajikan materi pembelajaran. √ Pengenalan CX –

Progammer
2. Guru memberikan beberapa contoh soal

serta langkah-langkah penyelesaiannya.
√

3. Guru memberikan kesempatan pada siswa
untuk bertanya bila ada materi yang belum
dimengerti.

√

4. Siswa mengerjakan contoh-contoh soal
yang diberikan oleh guru.

√ Mencoba
mendownload

program ke PLC
5. Siswa bersama guru membahas contoh-

contoh soal yang telah diberikan.
√
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6. Guru menyajikan soal yang berhubungan
dengan materi yang dipelajari.

√

7. Siswa mengerjakan soal tersebut,
kemudian siswa membuat soal sendiri dan
mengerjakan sendiri berdasarkan stimulus
yang diberikan guru tersebut.

√ Siswa membuat soal
dan didownload ke

PLC

8. Guru memantau siswa dalam membuat
dan mengerjakan soal.

√ Soal dikerjakan secara
berkelompok

9. Setelah selesai salah satu siswa
mempresentasikan dan menyelesaikan soal
yang dibuatnya.

√

10.Siswa yang lain mengoreksi soal yang
telah ditulis di papan tulis dan menanggapi
soal dan penyelesaian yang telah dibuat
temannya tersebut.

√

III. Penutup
1. Siswa bersama guru menyimpulkan materi

yang telah dipelajari.
√

2. Guru memberikan PR kepada siswa √ Membuat program
timer / counter

3. Guru meminta siswa untuk mempelajari
materi berikutnya.

√

4. Guru menutup pelajaran √
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LEMBAR OBSERVASI PELAKSANAAN PEMBELAJARAN
PLC DENGAN PENDEKATAN PROBLEM POSING

Nama Sekolah : SMK N 2 Wonosari Materi Pokok : Timer - Counter
Hari/Tanggal : Selasa, 14 Februari 2012 Siklus/Pertemuan ke : II / II
Kelas/Jam : XI EI / 07.00 – 10.15

Berilah tanda cek (√) pada salah satu kolom “Ya” atau “Tidak” yang tersedia dan
deskripsikan hasil pengamatan sesuai dengan apa yang telah anda amati selama proses
pembelajaran berlangsung.

No. Indikator/Aspek yang diamati Ya Tidak
Deskripsi Hasil

pengamatan
I. Kegiatan Awal

1. Guru mengawali pelajaran dengan berdoa. √
2. Guru mengecek kesiapan siswa. √
3. Guru menanyakan PR atau kesulitan siswa

dalam belajar.
√

4. Guru menyampaikan topik yang akan
dibahas.

√

5. Guru memotivasi siswa untuk
berpartisipasi aktif dalam pembelajaran.

√

6. Guru mengaitkan materi yang akan
dipelajari dengan kehidupan sehari hari.

√

7. Guru mengingatkan kembali materi yang
telah dipelajari sebelumnya.

√

II. Kegiatan Inti
1. Guru menyajikan materi pembelajaran. √ Cara kerja dan

penggunaan Timer –
counter

2. Guru memberikan beberapa contoh soal
serta langkah-langkah penyelesaiannya.

√

3. Guru memberikan kesempatan pada siswa
untuk bertanya bila ada materi yang belum
dimengerti.

√

4. Siswa mengerjakan contoh-contoh soal
yang diberikan oleh guru.

√ Mencoba
mendownload

program ke PLC
5. Siswa bersama guru membahas contoh- √
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contoh soal yang telah diberikan.
6. Guru menyajikan soal yang berhubungan

dengan materi yang dipelajari.
√

7. Siswa mengerjakan soal tersebut,
kemudian siswa membuat soal sendiri dan
mengerjakan sendiri berdasarkan stimulus
yang diberikan guru tersebut.

√ Siswa membuat soal
dan didownload ke

PLC

8. Guru memantau siswa dalam membuat
dan mengerjakan soal.

√ Soal dikerjakan secara
berkelompok

9. Setelah selesai salah satu siswa
mempresentasikan dan menyelesaikan soal
yang dibuatnya.

√

10.Siswa yang lain mengoreksi soal yang
telah ditulis di papan tulis dan menanggapi
soal dan penyelesaian yang telah dibuat
temannya tersebut.

√

III. Penutup
1. Siswa bersama guru menyimpulkan materi

yang telah dipelajari.
√

2. Guru memberikan PR kepada siswa √
3. Guru meminta siswa untuk mempelajari

materi berikutnya.
√

4. Guru menutup pelajaran √
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Tabel Hasil Tes Siklus I

No. Nama Siswa Hasil tes
1. Achmad Bagus Dewa P 96
2. Adi Irawan 56
3. Adib Rizal Fahmi 87
4. Aditya Dwi C 82
5. Alfian Rizky S 79
6 Arif Wahyudi 89
7. Bahtiar Nugroho 68
8. Damas Panji A 86
9. Dewi Aprilia 63

10. Dima Abdi Kurniawan 81
11. Dwiky Ardy C.P 68
12. Eko Budi Sn 71
13. Elva R.E 66
14. Fahmi N.S 45
15. Febri A 45
16. Ganjar T 37
17. Hendro 71
18. Ibnu Syambudi 66
19. Irfan E 54
20. Ismail F 56
21. Kasnuri Wahyudi 63
22. Kurniawan 76
23. Lilis R 63
24. Martha Adi N 83
25. Ndendik Hermawan 66
26. Panji Lelono 78
27. Pendi Hidayat 74
28. Pendri A 61
29. Rohmat Dwijayanto 86
30. Sidig Prianto 51
31. Sugeng Pratopo 74
32. Sugeng Riyanto 71
33. Tri Hayat Nurhidayat 86
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Tabel Hasil Tes Siklus II

No. Nama Siswa Hasil tes
1. Achmad Bagus Dewa P 89
2. Adi Irawan 69
3. Adib Rizal Fahmi 84
4. Aditya Dwi C 72
5. Alfian Rizky S 74
6 Arif Wahyudi 81
7. Bahtiar Nugroho 67
8. Damas Panji A 87
9. Dewi Aprilia 66

10. Dima Abdi Kurniawan 81
11. Dwiky Ardy C.P 75
12. Eko Budi Sn 76
13. Elva R.E 87
14. Fahmi N.S 58
15. Febri A 48
16. Ganjar T 56
17. Hendro 74
18. Ibnu Syambudi 71
19. Irfan E 52
20. Ismail F 64
21. Kasnuri Wahyudi 69
22. Kurniawan 71
23. Lilis R 67
24. Martha Adi N 71
25. Ndendik Hermawan 81
26. Panji Lelono 79
27. Pendi Hidayat 63
28. Pendri A 75
29. Rohmat Dwijayanto 85
30. Sidig Prianto 51
31. Sugeng Pratopo 89
32. Sugeng Riyanto 80
33. Tri Hayat Nurhidayat 92
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Catatan Lapangan Pertemuan Pertama

(Siklus I)

Hari, tanggal : Senin, 06 Februari 2012

Materi : Pengenalan PLC dan Gerbang Logika

Pada pukul 12.45 WIB semua siswa masuk ke dalam kelas. Guru, peneliti

dan observer memasuki ruangan kelas. Guru mengkondisikan siswa agar

mempersiapkan diri untuk mengikuti pembelajaran pada hari ini. Sebelum

pembelajaran dimulai, guru memberitahukan kepada siswa bahwa pelajaran hari

ini akan diberikan oleh peneliti. Guru kemudian mempersilahkan peneliti untuk

memberi pelajaran. Peneliti kemudian memperkenalkan diri kepada siswa dan

menjelaskan maksud dan tujuan melakukan penelitian dikelas XI EI SMK N 2

Wonosari. Kemudian peneliti mempersilahkan para siswa untuk duduk sesuai

dengan urutan absen dan dibagi ke dalam kelompok-kelompok kecil yang telah

ditentukan oleh peneliti. Hal ini dilakukan untuk memudahkan observer dalam

mengambil data.

Pelajaran dimulai setelah semua kelompok terbentuk. Peneliti

menyampaikan prosedur pembelajaran PLC menggunakan pendekatan problem

posing, dimana pembelajaran tersebut mengajak siswa untuk mencoba membuat

permasalahan berdasarkan pengetahuan yang diperlehnya. Peran guru hanya

menjadi fasilitator saja sehingga siswa diharapkan akan mampu mengkonstruk
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atau membangun pengetahuanya sendiri. Pembelajaran pada siklus I dimulai

dengan pengenalan PLC sebagai salah satu alat otomasi yang biasa digunakan di

dunia industri dan pengenalan logika dasar. Pada bagian ini siswa mencoba

untuk menerapkan logika dasar dalam kehidupan sehari-hari secara

berkelompok. Di akhir kegiatan ini siswa diminta untuk mengajukan

permasalahan beserta jawabanya. Kegiatan pembelajaran pada pertemuan

pertama ini peneliti menggunakan metode ceramah, tanya jawab, latihan dan

diskusi. Setelah memberikan materi kepada siswa dengan metode ceramah,

peneliti kemudian meminta salah satu kelompok untuk menyampaikan hasil

permasalahan yang dibuatnya dan tanya jawab tentang materi yang

disampaikan. Dalam mengerjakan soal siswa berdiskusi dengan teman

sekelompok. Saat mengerjakan soal banyak siswa yang masih ramai, tidak

memperhatikan dan dalam kelompok hanya beberapa saja yang aktif. Sedangkan

dalam menyapaikan hasil permasalahan yang dibuatnya respon siswa masih

kurang. Aktivitas siswa diamati saat pembelajaran berlangsung.

Pada akhir pembelajaran peneliti membimbing siswa dalam

menyimpulkan materi pembelajaran hari ini. Waktu pelajaran telah habis, peneliti

menginformasikan materi yang akan dipelajari besok masih tentang gerbang

logika. Peneliti menutup pembelajaran berdoa.
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Catatan Lapangan Pertemuan Kedua

(Siklus I)

Hari/Tanggal : Selasa, 07 Februari 2012

Materi : Gerbang Logika

Pertemuan kedua siklus I dilaksanakan pada hari Selasa tanggal 07

Februari 2011 pukul 07.00-11.15 WIB. Pada awal pertemuan kedua, peneliti

memeriksa kesiapan siswa dengan mengecek kehadiran siswa.

Siswa diminta duduk sesuai nomor urut seperti pada pertemuan pertama.

Peneliti memberikan penjelasan dan motivasi kepada siswa agar mau dan tidak

takut untuk bertanya dan menyampaikan pendapatnya. Peneliti menyampaikan

materi pembelajaran tentang gerbang logika PLC dan meminta siswa untuk

mencobanya di komputer menggunakan software simulasi PLC. Setelah semua

siswa telah mencobanya. Peneliti membagikan lembar contoh-contoh soal gerbang

logika untuk dikerjakan. Selama mengerjakan ini peneliti mendapingi kelompok

yang mengalami kesulitan.

Saat pembelajaran berlangsung aktivitas belajar siswa sudah mulai

Nampak. Siswa mulai bertanya kepada peneliti, lebih banyak yang mendengarkan

dan juga memperhatikan, sedang sebagian lain cenderung malu, enggan dan

bercanda dengan teman. Pembelajaran belum berjalan dengan baik tetapi ada

peningkatan dibandingkan dengan pertemuan sebelumnya. Hal tersebut
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kemungkinan karena siswa sudah menyesuaikan diri dengan metode pembelajaran

yang diterapkan.

Selanjutnya peneliti membimbing siswa untuk mengajukan masalah dan

juga penyelesaianya. Di pertemuan ini sudah mulai terlihat keberanian siswa

untuk mempresentasikan hasil masalah yang dibuatnya tanpa perlu ditunjuk dan

disuruh.

Setelah pembelajaran selesai kemudian peneliti menyiapkan lembar tes

siklus I dan membagikan kepada siswa. Peneliti meminta siswa untuk

mengerjakan dengan waktu 60 menit. Saat siswa mengerjakan peneliti mengamati

siswa dengan berkeliling disekitar siswa. Setelah selesai mengerjakan siswa

mengumpulkan lembar jawaban kepada peneliti.
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Catatan Lapangan Pertemuan Ketiga

(Siklus II)

Hari, tanggal : Senin, 13 Februari 2012

Materi : Pemrograman PLC menggunakan CX-Programmer

Pada pukul 12.45 WIB bel masuk istirahat berbunyi. Semua siswa

masuk kedalam kelas. Pada tahap awal pembelajaran siklus II ini, peneliti

menyampaikan kembali prosedur pembelajaran problem posing. Peneliti juga

mengingatkan kepada siswa agar bersungguh-sungguh dalam mengikuti

pembelajaran sehingga siswa paham dengan apa yang sedang dipelajari.

Pada pembelajaran ini peneliti mengulas materi gerbang logika yang telah

disampaikan sebelumnya. Di saat peneliti mengulas materi ada beberapa siswa

bertanya kepada peneliti yang mengalami kesulitan dalam mengerjakan soal tes

siklus I. Hal ini menunjukan rasa ingin tahu siswa meningkat, karena mereka

ingin bertanya jika ada soal dan pernyataan yang belum dipahami saat

mengerjakan soal. Kemudian peneliti menawarkan kepada para siswa apakah ada

yang bisa menjawab pertanyaan teman dan memberi penjelasan. Ada beberapa

siswa yang berani menjawab.

Kegiatan pembelajaran pada siklus II dilanjutkan dengan penyamapaian

materi mengenai pemrograman dan mendownload program dari komputer ke PLC

menggunakan software CX-Programmer. Siswa membuat program-program



117

sederhana yang dicontohkan peneliti di papan tulis. Pada kegiatan ini siswa

terlihat antusias karena mereka dapat mencobanya langsung ke PLC. Diakhir

kegiatan peneliti memberikan preview mengenai materi yang akan disampaikan

besuk mengenai timer-counter.

Pembelajaran berjalan dengan lancar dan kondusif walaupun untuk

mencoba mendowload program ke PLC setiap harus bergantian dalam mencoba.

Sebelum pelajaran berakhir, peneliti melakukan refleksi dan menginformasikan

agar siswa mempelajarinya dirumah apa yang telah dipelajari pada pertemuan hari

ini. Peneliti kemudian menutup pembelajaran dengan salam, pembelajaran

berakhir pukul 14.15 WIB.
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Catatan Lapangan Pertemuan Keempat

(Siklus II)

Hari, tanggal : Selasa, 14 Novemb 2011

Materi : Timer-Counter

Pertemuan kedua siklus II dilaksanakan pada hari Selasa tanggal 14 Februari

2012 pukul 07.00 – 10.15 WIB. Guru, peneliti dan rekan peneliti memasuki

ruang. Guru kemudian memberitahukan kepada siswa bahwa pelajaran masih

akan digunakan untuk penelitian. Guru menyampaikan kepada siswa untuk

megikuti pembelajaran yang diberikan oleh peneliti dengan serius.. Pada tahap

awal pembelajaran peneliti menyampaikan memberikan apersepsi kepada siswa

mengenai materi yang diajarkan.

Pertemuan kedua ini peneliti mengulas materi timer-counter dan

penggunaanya. Pada pertemuan ini peneliti menberikan contoh-contoh soal yang

diberikan pada setiap kelompok. Setiap kelompok diharuskan mengerjakan

contoh-contoh soal dan mengajukan masalah dalam waktu yang telah ditentukan.

Setelah selesai beberapa kelompok mengajukan diri untuk menyampaikan

permasalahan beserta penyelesaiannya di depan. Hal ini menunjukkan semakin

meningkatnya aktivitas siswa dalam mengikuti pembelajaran. Selanjutnya peneliti

membahas dan menjelaskan kepada siswa mengenai permasalahan yang di ajukan

oleh siswa. Saat peneliti menjelaskan banyak siswa yang memperhatikan

penjelasan yang diberikan. Pada siklus II siswa terlihat sudah menunjukkan

aktivitas belajarnya. Hal ini dapat dilihat dengan siswa semakin banyak yang
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bersemangat mengerjakan soal, mengajukan pertanyaan, menanggapi pertanyaan,

dan memperhatikan penjelasan yang diberikan oleh peneliti. Walaupun  masih ada

siswa yang mengerjakan soal sambil berdiskusi dengan teman sebangku sehingga

menyebabkan suasana kelas lebih ramai. Hal itu tidak menjadi masalah karena

siswa akan menjadi aktif.

Pada kegitan ini peneliti melakukan refleksi yaitu peneliti bertanya kepada

siswa tentang apa yang telah diperoleh siswa pada pembelajaran hari ini.

Kemudian peneliti membimbing siswa kembali menyimpulkan pelajaran pada hari

ini.

Kegiatan pembelajaran pertemuan kedua pada siklus II di akhiri dengan

melakukan tes siklus II kepada siswa. Siswa diberi waktu 60 menit untuk

mengerjakan soal test siklus II. Setelah selesai mengerjakan siswa kemudian

mengumpulkan hasil pekerjaan kepada peneliti. Kemudian peneliti menutup

pelajaran dengan salam dan pembelajaran berakhir pada pukul 10.15 WIB.



Lampiran 7
7.1 Surat ijin penelitian7.2 Surat pernyataan judgment7.3 Surat keterangan sudah melakukan penelitian7.4 Silabus Mata Pelajaran PLC7.5 Materi Mata Pelajaran PLC















NAMA SEKOLAH : SMKN 2 Wonosari
MATA PELAJARAN : Kompetensi Kejuruan Teknik Pemanfaatan Tenaga Listrik
KELAS/SEMESTER : XI/2
KOMPETENSI : Mengoperasikan mesin produksi dengan kendali PLC
KODE : PTL.OPS.006(2).A
DURASI PEMELAJARAN : 60 Jam @ 45 menit

Kompetensi Dasar Indikator Materi Pembelajaran Kegiatan Pembelajaran Penilaian
Alokasi Waktu

Sumber Belajar
TM PS PI

1. Mempersiapkan operasi
mesin produksi dengan
kendali PLC

• Peralatan yang berkaitan
dengan pengoperasian di-
identifikasi masing-masing
sesuai SOP

• Diagram kerja dan sistem
kelistrikan dipahami
berdasarkan standar praktis

• Tombol dan indikator operasi
diidentifikasi sesuai dengan
diagram dan urutan operasi

• Kebijakan dan prosedur K3
dipahami

• Meliputi jenis pengasutan
motor listrik sebagai peng-
gerak mesin produksi

• Mengikuti standar K3 dalam
pengoperasian pengoperasian
mesin produksi dengan
kendali PLC

• Mengkoordinasikan per-siapan
pengoperasian mesin produksi
dengan kendali PLC kepada
pihak lain yang ber-wenang

• Memahami SOP peng-
operasian mesin produksi
dengan kendali PLC

• Mengidentifikasi komponen
pengoperasi-an mesin
produksi dengan kendali PLC

• Memahami fungsi komponen
pengoperasi-an mesin
produksi dengan kendali PLC

• Memahami diagram kerja dan
sistem kelistrikan

• Memahami urutan operasi
mesin produksi dengan
kendali PLC

• Memahami kebijakan dan
prosedur K3 peng-operasian
mesin produksi dengan
kendali PLC

• Mempersiapkan pekerja-an
pengoperasian mesin produksi
dengan kendali PLC

• Memeriksa komponen
pengoperasian mesin produksi
dengan kendali PL

• Tes tertulis
• Tes lisan

12 • Modul
• Buku refrensi
• Trainer
• Job sheet

2. Melaksanakan operasi • Personel yang berwenang • Meliputi jenis pengasutan • Melakukan koordinasi • Praktikum 20 • Modul



Kompetensi Dasar Indikator Materi Pembelajaran Kegiatan Pembelajaran Penilaian
Alokasi Waktu

Sumber Belajar
TM PS PI

mesin produksi dengan
kendali PLC

dikoordinasi untuk meyakin-
kan bahwa pelaskanaan per-
siapan terkoordinasi secara
efektif dengan pihak lain
yang terkait

• Tombol atau indikator yang
berkaitan dengan operasi
dipersiapkan sesuai SOP

• Operasi dilaksanakan sesuai
deskripsi/urutan kerja pada
SOP

motor listrik sebagai peng-
gerak mesin produksi

persiapan pengoperasian
dengan pihak lain yang
berwenang

• Mengidentifikasi gambar
rangkaian kendali PLC sesuai
dengan rencana kerja

• Mengidentifikasi bahan dan
perlengkapan kerja
pemeliharaan kendali PLC

• Mengidentifikasi perleng-
kapan dan lokasi kerja
pemeliharaan kendali PLC

• Mengidentifikasi lokasi dan
keselamatan kerja pada
pekerjaan pemeli-haraan
kendali PLC

• Memilih bahan dan spare part
kendali Elektronik

• Menyiapkan tombol dan
indikator pengoperasian
mesin produksi dengan
kendali PLC

• Mengoperasikan mesin
produksi dengan kendali PLC

• Laporan
• Tes lisan

• Buku refrensi
• Trainer
• Job sheet

3. Mengamati dan
menangani masalah
operasi mesin produksi
dengan kendali PLC

• Gangguan yang berkaitan
dengan penyimpangan
operasi diidentifikasi, dengan
memperhatikan toleransi
yang ditetapkan sesuai
instruksi manual

• Penyimpangan yang
teridenti-fikasi penyebabnya
ditentu-kan altenatif
penanggulang-annya

• Altenatif penyelesaian
masalah dikonsultasikan
dengan pihak terkait di
tempat kerja

• Pemecahan masalah
ganggu-an dilaksanakan

• Meliputi jenis pengasutan
motor listrik sebagai peng-
gerak mesin produksi

• Mengkonsultasikan alternatif
pemecahan masalah
gangguan pada pihak terkait

• Menganalisa gangguan pada
pengoperasan mesin produksi
dengan kendali PLC

• Memahami cara meng-atasi
gangguan pada
pengoperasian mesin produksi
dengan kendali PLC

• Mengatasi gangguan pada
pengoperasian mesin produksi
dengan kendali PLC

• Praktikum
• Laporan
• Tes lisan

20 • Modul
• Buku refrensi
• Trainer
• Job sheet



Kompetensi Dasar Indikator Materi Pembelajaran Kegiatan Pembelajaran Penilaian
Alokasi Waktu

Sumber Belajar
TM PS PI

sampai dengan gangguan
diselesai-kan

4. Membuat laporan peng-
operasian

• Laporan dibuat sesuai
dengan format dan prosedur
yang ditetapkan oleh
perusahaan.

• Format laporan disimpan/
diarsipkan sesuai prosedur
yang ditetapkan

• Meliputi jenis pengasutan
motor listrik sebagai peng-
gerak mesin produksi

• Mengikuti prosedur pem-
buatan laporan

• Mengikuti prosedur pe-
nyimpanan/pengarsipan
laporan

• Memahami cara mem-buat
laporan pengopera-sian mesin
produksi dengan kendali PLC

• Membuat laporan peng-
operasin mesin produksi
dengan kendali PLC

• Praktikum
• Laporan
• Tes lisan

8 • Modul
• Buku refrensi
• Trainer
• Job sheet
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Materi Pelajaran PLC

A. Logika Dasar
1. Logika AND

Keluaran gerbang And akan high (1) jika semua masukan high (1). Jumlah dari
masukan tidak dibatasi, tetapi terdiri dari satu keluaran.

Tabel Kebenaran AND
Input Output

YA B
0 0 0
0 1 0
1 0 0
1 1 1

2. Logika OR
Keluaran gerbang OR akan high (1) jika salah satu atau semua masukan high (1).
Jumlah dari masukan tidak dibatasi, tetapi hanya terdiri dari satu keluran.

Tabel Kebenaran OR
Input Output

YA B
0 0 0
0 1 1
1 0 1
1 1 1

3. Logika NOT
Logika NOT mempunyai satu masukan dan satu keluaran. Keadaan masukan dan
keluaran berlawanan. Jika kondisi masukan high (1) maka kondisi keluaranya
low (0). Begitu juga sebaliknya jika kondisi masukan low (0) maka kondisi
keluaran high (1).

Tabel Kebenaran NOT
Input

A
Output

Y
0 1
1 0
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4. Logika NAND
Keluran gerbang NAND akan high (1) jika salah satu atau semua masukan low
(0). Jumlah dari masukan tidak dibatasi, tetapi hanya terdiri dari satu keluaran.

Tabel Kebenaran NAND

5. Logika NOR
Keluran gerbang NOR akan high (1) jika semua masukan low (0). Jumlah dari
semua masukan tidak dibatasi,tetapi hanya terdiri dari satu keluaran.

Tabel Kebenaran NOR

6. Logika Exclusive OR (XOR)
Berdasar tabel kebenaran, keluaran gerbang XOR akan high (1) jika salah satu

masukan dalam kondisi high (1).
Tabel Kebenaran XOR

Input Output
Y

A B
0 0 1
0 1 1
1 0 1
1 1 0

Input Output
A B Y
0 0 1
0 1 0
1 0 0
1 1 0

Input Output
A B Y
0 0 0
0 1 1
1 0 1
1 1 0
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B. Timer dan Counter
1. Timer

Fungsi yang digunakan untuk menghitung waktu mundur dari nilai set. Timer di-
on-kan dan direset sesuai dengan kondisi eksekusinya. Instruksi Timer
digunakan untuk operasi tunda waktu

2. Counter
Counter merupakan Fungsi yang digunakan untuk mencacah berapa kali bit atau
kondisi eksekusi berubah dari OFF ke ON.

C. Pemrograman PLC
1. Jenis-Jenis Alat Pemrogram

Ada beberapa jenis alat untuk memasukkan program ke dalam PLC yaitu:
- Komputer yang dilengkapi dengan software ladder misalnya CX-

Programmer
- Konsol Pemrogram, dan
- Programmable Terminal.

2. Memasukkan Program Menggunakan CX-Programmer
CX Programmer adalah software ladder untuk PLC merk OMRON. Ia

beroperasi di bawah sistem operasi Windows, oleh sebab itu pemakai software
ini diharapkan sudah familier dengan sistem operasi Windows antara lain untuk
menjalankan software program aplikasi, membuat file, menyimpan file,
mencetak file, menutup file, membuka file, dan keluar dari (menutup) software
program.

Ada beberapa persyaratan minimum yang harus dipenuhi untuk bisa
mengoperasikan CX Programmer secara optimal yaitu:
- Komputer IBM PC/AT kompatibel
- CPU Pentium I minimal 133 MHz
- RAM 32 Mega bytes
- Hard disk dengan ruang kosong kurang lebih 100 MB
- Monitor SVGA dengan resolusi 800 x 600

a. Menjalankan CX Programmer
Ada banyak cara untuk menjalankan suatu software termasuk CX

Programmer. Berikut ini ditunjukkan cara umum menjalankan software
dalam sistem operasi Windows.

Klik tombol Start > Program > OMRON > CX-Programmer >
CXProgrammer. Akan tampil Layar CX Programmer sebagai berikut:
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Gambar  Layar interface utama
Ada beberapa menu/command yang perlu diketahui pada layar
CXProgrammer utama yaitu:

- Menu/Command Fungsi
File>New Membuat file baru
File>Open Membuka file
File>Exit Keluar dari CX-Programmer
View>Toolbar Menampilkan/ menyembunyikan toolbar
Tool>Option Mengatur beberapa opsi :
Help Topic Meminta penjelasan menurut topik
Help Content Meminta penjelasan menurut isi
b. Membuat file baru

Klik File, New untuk membuat file baru. Kotak dialog Change PLC
ditampilkan

Gambar Kotak dialog merubah PLC
Pada kotak Device Type, pilih tipe PLC yang akan digunakan. Kemudian
pilih OK. Layar CXProgrammer ditampilkan.
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Gambar  Layar CX-Programmer

c. Menggambar Diagram Ladder
CX-Programmer membebaskan pemakai untuk membuat program dalam

bentuk diagram ladder atau mneumonik. Tetapi, akan lebih baik
menggunakan program diagram ladder. Pemakai juga dibebaskan untuk
menggunakan operasi toolbar, atau shortcut keyboard. Fungsi masing-masing
toolbar dan shortcut ditunjukkan pada table berikut ini :
Menu/ Comand Shortcut             Toolbar

Insert>Contact>Normally Open C

Insert>Contact>Normally Closed /

Insert>Vertical>Up U

Insert>Vertical>Down V

Insert>Horizontal -

Insert>Coil>Normally Open O

Insert>Coil>Normally Closed Q

Insert>Instruction I

d. Menyimpan File
- Klik File Save untuk menyimpan file. Muncul kotak dialog Save CX-

Programmer File.
- Pilih tempat memori dimana file akan disimpan. Misalkan file akan

disimpan di floppy disk, maka pilih 3½ Floppy (A:). lalu klik tombol save.
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- Sekarang, file proyek telah disimpan dalam memori dan file ini dapat
diakses setiap saat untuk ditindak-lanjuti.

e. Menutup File
- Klik File> close untuk menutup file.

f. Mentransfer program ke dalam PLC
Operasi pemrograman PLC dibedakan menjadi operasi offline dan

operasi online.
- Operasi offline adalah kegiatan pemrograman yang tidak memerlukan unit

PLC, misalnya membuat diagram ladder, menyimpan file.
- Operasi online adalah kegiatan pemrograman yang tidak dapat dilakukan

tanpa adanya unit PLC, misalnya mentransfer program, memonitor program,
dan menjalankan program.

transfer program dibedakan menjadi dua yaitu:
- Download adalah pemindahan program dari komputer ke PLC, sedangkan
- upload adalah pemindahan program dari PLC ke komputer.

Operasi transfer program hanya dapat dilakukan dalam mode operasi
PROGRAM. Jika PLC tidak dalam mode ini, CX-Programmer akan merubah
mode secara otomatis.

Prosedur transfer program dari komputer ke PLC (Download) sebagai
berikut :
1) Klik menu PLC > Work Online, untuk beralih ke operasi online.

Pada layar muncul pesan meminta konfirmasi untuk beralih ke operasi
online. Klik Yes untuk melanjutkan operasi. Latar belakang layar diagram
ladder berubah menjadi gelap yang menunjukkan anda sedang berada pada
operasi on-line.

2) Klik menu PLC > Transfer > To PLC untuk mendown-load program.
Muncul kotak dialog yang meminta penjelasan apa saja yang akan di
transfer: program atau setting, atau keduanya. Setelah dipilih, klik OK.
Kotak dialog konfirmasi transfer program ditampilkan. Konfirmasi ini
penting karena perintah transfer program akan berpengaruh terhadap PLC
yang disambung.

3) Klik Yes untuk melanjutkan operasi. Pada layar ditunjukkan operasi
transfer program sedang berlangsung. Jika selesai, ada informasi:
Download successful. Klik OK. Program anda sekarang sudah ada di PLC.


